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1. General
Thank you for purchasing Gorilla, film and video scheduling and budgeting
software that will help you produce your film, video, commercial, short,
webisode, television series, documentary, industrial, or just about any media
project that needs to be scheduled and budgeted . We at Jungle Software are
very excited about this new release. We have added hundreds of new features
to Version 5, plus redesigned the user interface to make Gorilla even easier to
use.
Just as your story has a beginning, middle, and end, so does the creation of
your project. Our software, and this reference guide, will help to guide you
through the various steps as you write, produce, and eventually distribute your
project.
We would like to thank the innumerable independent filmmakers who helped
us make Gorilla what it is today. Your suggestions and advice continue to make
us strive to improve this system for producing movies. We created Gorilla for
you, and we sincerely hope that Gorilla helps to bring your story to the big
screen.

1.1

Installation

Windows Installation
To install Gorilla for Windows, do the following:
Download the latest installer for the version you purchased. You can download
all installers from:
http://www.junglesoftware.com/support/downloads.php

Double-click the Gorilla 5.0.0.exe file, as shown above.
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Follow the instructions in the installer.
When the installer finishes, a folder named Gorilla Folder will be placed where
you designated the program to install.
Inside the Gorilla 5 Folder you will find a Gorilla 5.0.0 folder along with some
other folders:

Launch the application by double-clicking the Gorilla.exe icon in the Gorilla
5.0.0 folder.
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Continue with Registration below.
Macintosh Installation
To install Gorilla on Macintosh OS X, do the following:
Download the latest installer for the version you purchased. You can download
all installers from:
http://www.junglesoftware.com/support/downloads.php
You will download a .zip file, as shown below:

Double-click the file to unzip it:
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Then double-click the Install Gorilla 5 installer which should appear on your
desktop.
Follow the instructions in the installer.
When the installer finishes, a folder named Gorilla Folder will be placed in the
Applications directory.
Inside this folder you will find a Gorilla icon.

Launch the application by double-clicking the Gorilla icon in the Gorilla 5.0.0
folder.
If you wish, drag this icon to your dock.
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----------------------------------------------------------------------Enter your name and company name as it appears in your registration
confirmation e-mail.

In the activation screen, enter your serial number. This number begins with a
GR50.
The next step is to authorize Gorilla.
Internet Authorization

If your computer is connected to the internet, click Internet. Gorilla
will authorize in a few seconds. If your computer is not connected to the
internet, either authorize Gorilla at a later time or authorize Gorilla
manually.
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Manual Authorization
To manually authorize Gorilla, contact Jungle Software with your
Machine ID and your Challenge Code. We will give you a Response Code.
Enter the Response Code to authorize Gorilla.
Problems Authorizing
If you have problems authorizing via the Internet, before calling Jungle
Software, try disabling any Anti-Virus software (for example Norton AntiVirus). When authorizing, the Gorilla program needs to receive
information from our server and any Anti-Virus software or firewalls may
prevent the software from receiving this information.

1.1-1

Registering Gorilla

Gorilla is registered by entering a unique serial number.
If you purchased the box (versus the downloadable version), you still need to
download the Gorilla installer from our website. We do not package CD’s in our
boxes anymore because the Internet is a faster and more efficient way to
distribute updates to our software. However, if you have a box, a Box Code is
included on a yellow card. This box code is not the serial number. In order to
receive the serial number, do the following:
Via Internet: Go to www.junglesoftware.com and click Register. Enter your
name (minimum of 8 characters), company name (minimum of 8 characters),
and a valid email address. A serial number will be emailed within minutes.
Via E-Mail: Send an e-mail to support@junglsoftware.com with your box code,
Name and Company Name. We will generate a serial number for you and e-mail
it to you.
To register Gorilla, enter your name and company name exactly as you entered
them when you requested the serial number.

1.1-2

Authorizing Gorilla

Gorilla must be authorized within five days of being registered. If Gorilla is not
authorized within 5 days of being registered, the program will not launch.
With every single-user copy of Gorilla purchased, the software owner is allowed
to authorize Gorilla on two (2) computers.
Both of these computers must be owned by the owner of the software. You
are not allowed to give a friend (whether they are your producer or not!) a
copy of Gorilla to use on their computer while you are using a copy of Gorilla
on your computer. For multiple users, you can upgrade to a Director Pack,
Producer Pack, or a Crew Pack.
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A Director Pack allows Gorilla to be installed on up to three (3) computers. A
Producer Pack allows Gorilla to be installed on up to four (4) computers. A
Crew-Pack allows Gorilla to be installed on up to five (5) computers.
Authorizing Gorilla can be accomplished via the internet or by phone.
Gorilla will prompt you to authorize each time it is launched until you do so.
For special pricing on multi-user licenses, please contact Jungle Software.
Important Note: Gorilla must be registered before it can be authorized.

1.1-3

Deauthorizing Gorilla

If you are replacing your computer, you may wish to deauthorize Gorilla. To do
so, launch Gorilla and from the Authorize menu, select Authorize. You will
see the following screen. Click Deauthorize.
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1.2
1.2-1

Interface
The Toolbar

Use Gorilla’s Toolbar to navigate throughout the different modules.

The buttons on top display the category and the buttons below display the
modules for the highlighted category.
Gorilla is divided into two major components – a scheduling component and a
budgeting component. Each project can have multiple schedules and multiple
budgets. So for example:
Project:

My Video Project

Schedules:

My Video Schedule #1
My Video Schedule #2

Budgets:

My Video Budget #1
My Video Budget #2
My Video Budget #3

The above example shows one project called: My Video Project. This project
has two schedules and three budgets.
When you first launch Gorilla you are always taken to the Scheduling/Manager
window. This is where you can create projects and schedules.
If you close the Gorilla Toolbar, you can always bring it back by selecting:
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1.2-2

Menu Navigation and Keyboard Shortcuts

You can also navigate around Gorilla using the Navigation menu.

Printing
To print a report, select Print from the File menu and click the desired
report. Gorilla can print over 50 industry standard reports.

1.3

Saving Gorilla

Gorilla saves itself every time the user makes a change. The data is
automatically merged with the application in the .gor files.
Budgets and Schedules can be saved to external files that can be emailed to
other Gorilla Users. More information about this is available is Section 2.
It is, however, very important to always keep a recent backup of the Gorilla
folder in case of a system or hard drive crash.
Important Note: Do not copy any .GOR files from one Gorilla Folder to
another! This is not how you copy characters, for example, from one Gorilla
Folder to another.
To create a backup of a Gorilla folder on a hard drive, we recommend using the
OS’s built-in compression utility. Compress the entire Gorilla folder and name
it with the current date.
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In this way, multiple copies of the compressed Gorilla folder can be saved on
the same hard drive. It is also a good idea to periodically copy these archives to
an external media source, such as a CD, Zip drive, or a network drive.
Important Note: Exit Gorilla before making a backup. Gorilla files can
be damaged if a backup is attempted while Gorilla is open.

1.4

Extensions Folder

In the Gorilla 5.0.0 folder, there is an Extensions Folder. Inside this folder are
plug-ins and dictionary files that are required to run Gorilla.
Do not move or delete this folder or the contents inside the folder.

1.5

Recovering Corrupted Files

If your computer crashes for any reason while Gorilla files are open, Gorilla
might get corrupted. Gorilla can usually repair a corrupted file on its own.
Gorilla will display the message This file was not closed properly.
If in the rare case the file cannot open, the file needs to be recovered. You can
contact us at support@junglesoftware.com and we can attempt to recover any
damaged files.
If your file cannot be recovered, reinstall Gorilla from a backup or from the
installer. This is why it is imperative to periodically save your schedules and
budgets outside Gorilla. See Section 2 on how to do this. You can load your
saved schedules and budgets into the new file.
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2. Projects
2.1

Overview

A project is a distinct film, video, short, or any project that has its own story
and production schedule and/or budget.

2.1-1

Creating a Project

There are many ways to create a project. You can create a project from
scratch, load a schedule (.grs) file, or import a screenplay.
To create a new project, do the following:
From the File menu, select Create Project.

Enter a name for the project in the Project Name Field.
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Click OK. You will then go to the following screen where you can choose an
option:

To create a New schedule click on the New button.
Next you will be prompted to either Import a screenplay, or to create a Blank
schedule.
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If you click Import a screenplay, you will be taken to the My Screenplays folder,
as shown below.

This will allow you to select a screenplay file (in the .sex file format) that is
located in the My Screenplay folder in your Gorilla folder.
You can select a screenplay file from this list, or select the Import Screenplay
button to choose another screenplay file on your hard drive.
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Once selected, the screenplay will be imported into Gorilla.

2.1-2

Loaded Schedules

On the bottom half of the Scheduling Manager screen you will see the
following:

This shows you all schedules that are loaded into Gorilla. To make one active,
select it.
To load a schedule that is not visible in the list, select the green add button.
Then select the Load button:
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This will show you all schedule files that are located in the My Schedules folder
which is inside your Gorilla Folder (path below):
Gorilla 5/Saved Schedules/My Schedules
Any schedule file you place in this folder will appear in this list in Gorilla. This
makes it easy to quickly locate and load any Gorilla schedule.
You can change this path so that you can save your schedule files anywhere on
your hard drive. To do this, select the File Path to My Schedules
button, and then select the Change File Path button.

If you change the file path and want to change it back to the default setting,
click the Default button.
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If you want to load a schedule file that is not in this list, select the Load
Other… button.

2.1-3

Updating My Schedules and My Screenplays tab

If you add a file or files to the My Schedules or the My Screenplays folder and
the files in the list do not update, you can manually update the list by selecting
Update My Schedules Tab or Update My Screeplays Tab from the
View menu.

Relaunching Gorilla will also automatically update the lists to correspond what
files are placed in those folders on your hard drive.

2.1-4

Saving a Schedule

Gorilla saves your work as you go. It is always a good idea to save your schedule
outside of Gorilla for backup purposes, revision control, computer, program, or
hard drive crashes, or if you want to move a schedule to another computer
with Gorilla installed on it.

A dialog box appears as seen below:
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If the checkbox Automatically save to My Schedules folder is
selected, the file will be saved in your My Schedules Folder. This makes it easy
for you to load in case you delete the schedule from Gorilla.
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2.1-5

Deleting a Schedule

To delete a schedule from Gorilla, select the Delete button to the right of the
schedule name.

This will remove the schedule from Gorilla.

2.1-6

What is saved in a Schedule file?

The following components are saved in a schedule file:
Everything under the following Toolbar folders:
Scheduling, Contacts, Locations, and Storyboard

This includes:
Breakdown Sheets
Calendar (Shoot Days, Call Times, etc.)
Elements
Stripboard
Contacts (Actors, Crew)
Locations
Storyboard and Shots
Because all the above information is integrated within one schedule, it is saved
as a whole for that schedule.

2.2

Production Company

Under the Production Company tab, you can enter one or more production
companies, including addresses, phones, e-mails, and logos to appear on the
header of many reports.
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2.2-1

Creating a Production Company

Click on the green add button to select an existing or to create a new
company.

Companies are attached to schedules, however they can be shared within the
same project. In the example above, the company My Production Company is
attached to the schedule: Hotel Cucaracha, but can be attached to any
schedule created within the project: Hotel Cucaracha Series.
By attaching a company to a project, you can then attach that company (and
related address and phone) to your header for reports (Scene/Cast Call Sheet,
Crew Call Sheet, etc.).

2.2-2

Attaching a Logo to a Schedule

To go to the Logo screen, click on the button (shown below) for that schedule.

Click on the Logo & Report Headers tab and you will be taken to the following
screen:
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This screen is the: Logos & Report Headers tab.
If you created and attached a company to a project, this is where you can
specify that company to display on your report headers.
To select a company, select it in the Report Headers box.
To import a logo, select an empty box. You can then select a .png or a .jpg
image file to import.

The smaller the file size, the better. To make this logo active, select the
Default checkbox next to the logo name.
You can then customize how you want your headers to appear on your reports
by selecting the appropriate checkboxes as shown below.
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2.3

Importing from a Screenplay Program

Gorilla can import characters and breakdown sheet information from Final
Draft, Movie Magic Screenwriter, or Montage. The following screenplay formats
are accepted:
Format

Explanation

.sex

This is the original screenplay export
format. Final Draft versions 6, 7, and 8
and Movie Magic Screenwriter and
Montage are all known programs that
can export into this file format.

.xml

Final Draft version 7 can export into
this file format.

2.3-1

Preparing the Screenplay

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 1 – Preparing a Screenplay
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Before importing from a screenplay program, the screenplay must be properly
formatted. Make sure that:
**All scene headings are numbered with a unique number.
**Action line items are not designated as scene headings.
The slug line must be formatted properly in the screenplay to adhere to
production standards.
Example of Proper Slug Line:
INT. HOUSE – DAY
Use a period after the INT./EXT. field.
Use a single dash (-) after the SET NAME and before the DAY/NIGHT field.
The Set should be only the Set. Do not enter a time in this section, which
includes “MOMENTS LATER” or “CONTINUED”.
The DAY/NIGHT field should be written with any of the following acceptable
times of day: Afternoon, Day, Dusk, Evening, Midnight, Morning, Night, Sunrise,
Sunset, Twilight.
Examples of Improper Slug Lines:
INT. – HOUSE – (MOMENTS LATER) – DAY
INT. HOUSE. DAY.
INT. HOUSE – MOMENTS LATER – DAY
In the above examples, “Moments Later” is in the SET field. This is not proper
screenplay formatting for prodution.
Importing Elements
Gorilla can import elements from either Movie Magic Screenwriter, Final Draft
7 with Tagger or Final Draft 8 with Tagger 2.
Important Note: Movie Magic Screenwriter’s “auto-entry” option for
DAY/NIGHT is not compatible with Gorilla. These Day/Night fields will NOT be
imported into the breakdown sheets.

2.3-2

Exporting the Data

Next, export the information from the screenplay.
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Final Draft
Final Draft has two ways it can export a screenplay into a format Gorilla can
read.
Final Draft Without Tagger (version 7 and 8)
Open the screenplay and make sure that all the scenes are numbered. To do
this, click Production on the Command Bar, and select Scene Numbers…
Select the Number/Renumber checkbox and click OK.
Version 7: To Export, Click File in the Command Bar, and select Save As. In
the format dialog box, select Movie Magic.
Version 8: To Export, Click File in the Command Bar, and select Export. In
the format dialog box, select Scheduling Export (*.sex).

This will save a file with the .sex extension.
Final Draft 7 or 8 With Tagger
Open Tagger. Click File on the Command Bar and select Import Script.
Tag the elements using the preset category names.
Select Export to Schedule from the File menu. This will save a file with
the .sex extension.
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Movie Magic Screenwriter
Open the screenplay and select Breakdowns from the Production menu and
then Export to Scheduling.

This will save a file with the .sex extension.
The export file is now ready for import into Gorilla.

2.3-3

The My Screenplays Folder

Upon installation a folder called My Screenplays is created in your Saved
Schedules folder:
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You do not have to use this folder, but if you place your screenplay files in this
folder you can automatically load them into Gorilla by selecting the green add
button and then selecting the New button.

Any screenplay file in the My Screenplays folder will appear in the above list.
To create a new schedule and automatically import a screenplay simply select
the screenplay in this list. Upon clicking the screenplay, you will be prompted
with the following dialog:
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When importing a screenplay, a new schedule is always created.

2.3-4

Changing the File Path to the My Screenplays Folder

If you want you can change the file path of the My Screenplays folder. If you
already have a folder where you like to keep all you screenplay files, you can
tell Gorilla to change the path of the My Screenplays list to display screenplays
from that folder. To do this, click on the File Path to My Screenplays
button:

This will display the following screen displaying the current path to the My
Screenplays folder:
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Click on the Change File Path button to navigate to the folder where
you would like to display your screenplays.

2.3-5

Importing Screenplay Tips

Character Formatting
If imported separately, there can be up to three characters in the Characters
Module that stand for that character. For example, if a character named BILL
has (O.S.) and/or (V.O.), then the following will be imported into the
Characters Module:
BILL
BILL (O.S.)
BILL (V.O.)
In this example, Bill will be broken down on the breakdown sheets following
that naming convention. This might make it clear when Bill is actually needed
for that shoot day, or if Bill is only needed for voice over work, which usually is
done in post-production.
All character names with the (CONTD) tag will be merged with the character
name unless the “Do not parse the characters…” has been selected.
Checking for Errors
Please check the breakdown sheets after importing is complete as some
corrections may be required. For example, if the last word in a screenplay’s
description line does not read: DAY, NIGHT or another time of day, this field
will have to be manually fixed. Some writers will write:
EXT – BUILDING – MOMENTS LATER
Gorilla will read this as:
EXT
BUILDING
MOMENTS LATER

I/E Field
Set Field
D/N Field (this is where DAY or NIGHT should be)

To fix this problem, “Moments Later” will have to be manually changed to a
time of day.

2.4

Importing a StoryO File into Gorilla

Upon creating a new project you also have the option of importing a StoryO
file. To export a file from StoryO in order for import into Gorilla, follow the
following steps:
1. Open StoryO and open the project you want to export.
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2. Go to the Timeline module.

3. From the File menu select Export and select the Scheduling to
Gorilla option.

4. This will export a .tab file.
5. Open Gorilla and create a new project.
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6. From the File menu, select the Import StoryO File… option.

7. Find the .tab file and open it.
8. When finished, go to the Breakdown module and you will see your StoryO
project converted to breakdown sheets. You can then create a
Production Phase and create Shoot Days.
In order to view your index cards that were imported from StoryO, select
the small Index Card button next to the Synopsis line:
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For more information, see the chapter on Index Cards in Chapter 8, Scheduling.
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3. Breakdown
3.1

Overview

The Scheduling Module is used to create shoot days, breakdown a script,
schedule scenes to shoot, and run call time, scene, and other related
scheduling reports.

3.2

Breakdown Sheets

Breakdown Sheets are scenes converted from your screenplay. Each scene is
imported from your screenplay and a corresponding breakdown sheet is created
with or without attached elements for that scene.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 3 – Breakdown Sheets, Part 1
To access the Breakdown module, select Breakdown in the Toolbar.

This will take you to the Breakdown screen. If you imported a screenplay, you
will see breakdown sheets on this screen.
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3.2-1

Explanation of Breakdown Sheet Components

The following is an explanation of all the components of a breakdown sheet.

On the top left you will see the following fields.
I/E

This is the INT./EXT. field. This can be imported from your
screenplay.

Set

This is the Set field. This can be imported from your
screenplay.

Synopsis

You can enter a short synopsis of the scene here. It will
appear on certain reports, including the Scene/Cast Call
Sheet report.

Location

You can enter the location where the scene will be shot. All
locations are stored in the Locations module.
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D/N

This is the Day/Night field. This can be imported from your
screenplay.

Page Count

This is the Page Count field. This can be imported from your
screenplay. Page Counts are measured in whole pages and
eighths of pages.

Sheet #

The Sheet number is a way you can number your breakdown
sheets.

Script Day

Need description here.

Phase

This is the phase that this breakdown sheet is attached to.

Est. Time

If you want you can enter the estimated time it will take to
shoot this scene.

Unit

You can enter which production unit will be shooting this
scene.

Sequence

You can enter a sequence name for this scene.

On the left hand side of the screen, you will see a list of Categories.
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Each time a new schedule is created,
a default list of Categories is created.
You can create as many categories as
you want. You can also modify the
existing categories. To manage
categories, select Manage
Categories from the Edit menu.
Each Category can have its own color
and text formatting options.
To create a new category, select the
green add button.

3.2-2

Creating Breakdown Sheets

As mentioned earlier, usually breakdown sheets are imported from a
screenplay, however, you can create breakdown sheets manually. To create a
breakdown sheet, select New Breakdown Sheet from the File menu.
Fields that should be filled are: I/E, Set, D/N, Page Count, Scenes.
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This is because these are also the fields that display on the stripboard and
Scene/Cast Call Sheets.

3.2-3

Navigating to Breakdown Sheets

A full-length screenplay can have over a hundred breakdown sheets. To help
navigate to them, you can use the Scene Navigator on the right-hand side of
the screen.

To go to a specific breakdown sheet, select the breakdown sheet in this list.
The grey box around the breakdown sheet indicates that this is the currently
displayed breakdown sheet.
You can change the sorting of this list by clicking on the Sort button in the top
left-hand side of this window.
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3.2-4

Duplicating Breakdown Sheets

Sometimes you will need to duplicate a breakdown sheet. This is because you
might want to schedule a scene to be shot over a 2-day or more period. If you
have two breakdown sheets for the same scene (i.e.: Scene 1, Sheet 1 and
Scene 1, Sheet 2), you can schedule them on different days on the Stripboard.
In order to duplicate a breakdown sheet, select Duplicate Breakdown
Sheet from the File menu.

Notice below that the duplicate breakdown sheet duplicates the Scene #
(Scene 1-copy).
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If you go to the Stripboard you will see the new sheet in the stripboard in the
Unscheduled area (above the Boneyard strip).

You can now move the strip out of the Unscheduled Area onto the Stripboard
for Scheduling. In this way it can be scheduled across two days. You might want
to change the page count for the scene which you can do on the breakdown
sheet for each scene.

3.2-5

List Breakdown Sheets

Another way to view and navigate to breakdown sheets is to use the List
Breakdown Sheets command on the Breakdown menu.
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This will display all your breakdown sheets in an Excel-like display. To navigate
to a specific breakdown sheet, select the blue triangle next to the breakdown
sheet.
To sort the list click on a column header, i.e.: Set.
You can delete a breakdown sheet or multiple breakdown sheets by clicking on
the red “X”. Warning! Deleting breakdown sheets on this screen does not give
you any warning. They delete instantly and cannot be retrieved!

3.2-6

Merging Breakdown Sheets

If you want to merge or combine breakdown sheets, select the Merge
Breakdown Sheets command on the Breakdown menu.
By selecting a breakdown sheet from the new window, you will merge the
existing breakdown sheet with the newly selected breakdown sheet. This will
merge all elements to the primary breakdown sheet and delete the secondary
breakdown sheet.

3.2-7

Attaching Elements to Breakdown Sheets

To attach an element to a breakdown sheet, go to the breakdown sheet you
want to attach elements to. Select a Category:

-38-

In the example above, the Props category is selected. All props will be
displayed in the window next to the Category window.
To attach the element “Broom” to the current breakdown sheet, select it the
arrow next to the prop: Broom.

This will add the element “Broom” to the breakdown sheet, as shown above.

3.2-8

Modifying Quantity of Elements on Breakdown Sheets

If you want to add more than one of the same element, you can change the
Quantity of that element on each breakdown sheet.
Notice below the quantity is changed to “3”. This can prevent displaying the
element “Broom” three times on the breakdown sheet.
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3.2-9

Creating New Elements on Breakdown Sheets

To create a new element, select the green add button on the breakdown sheet.

This will display the following screen:

By default the Category shown will be the category that is selected on the
current breakdown sheet. Enter a name for this element and specify a
Category.
*Every element must be attached to a Category.
If the checkbox “Add this element to current breakdown sheet”, the element
will also be added to the current breakdown sheet.
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If you want to continue to add elements, select the checkbox: “When click OK
add another element”.

3.2-10

Index Cards

On each breakdown sheet, you can enter more information about the story or
the scene on index cards. By selecting the Index Card button (see below), an
index card will appear for that breakdown sheet.

You can also change the text size and the text formatting of an index card by
selecting appropriate options from the Format menu:

You have the option of entering information on the back of an index card by
clicking on the blue arrow.
To print the index cards select Print from the File menu and select the Index
Cards report.
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If you are importing index cards from StoryO, the following information will be
imported: (below in a screenshot from StoryO).
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1) Title of Index Card
2) Front of Index Card
3) Back of Index Card
4) I/E field
5) Set field
6) D/N field
7) Characters attached to Index Cards
8) Scene Number
9) Scene Description

3.2-11

Viewing/Printing Breakdown Sheets

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 5 – Printing Breakdown Sheets
Breakdown Sheets can be printed in a variety of formats.
One of them is the industry-standard “boxed” breakdown sheet form. To view
and customize this form, select Show Printable Breakdown Sheets from
the Breakdown menu.
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This will take you to a screen that will show you your breakdown sheet
categories separated by boxes.
This is the industry-standard way of printing breakdown sheets. It is used
because it is a simple and easy to quickly look at the sheet for a scene and see
what elements are needed.
Gorilla allows you to print your breakdown sheets in this manner, however,
there are limitations to this print method which will be explained below.
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You can select any one of 6 different layouts to print your breakdown sheets.
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Each layout allows for a different
amount of space for each category.
So for example, if you have elements
that are longer than the allowed space
for that box, you can select a
different layout to display that
breakdown sheet.
By selecting a layout, you will be able
to print that breakdown sheet in that
layout.
To view a different breakdown sheet,
select the scene in the Scene
Navigator.
Only the first box on each layout has
the ability to display the Board ID for
Cast Members.
You can print breakdown sheets in this
format as long as there are no more
than 21 categories. You can change a
category for a box by simply clicking
on the box. This will allow you to
select a different category for that
box.
If you have more than 21 categories,
you need to print breakdown sheets
using the Breakdown Sheet Summary
report.

In order to print breakdown sheets, select the Print button.
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This will display the following screen:

These are the limitations for printing breakdown sheet boxes:
1. You can only print up to 5 pages for each breakdown sheet. If you have
more elements than this allows, you need to either select a different
breakdown sheet layout that allows for more room for that category, or
print the Breakdown Sheet Summary report.
2. You can customize a breakdown sheet to print for a specific layout then
select “This Sheet Only”, which will only print the sheet you are
currently viewing.
Another way to print breakdown sheets without any limitations on (a) how
many elements, or (b) how long an element is, or (c) how many categories a
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schedule has, is to print the Breakdown Sheet Summary report, which is a
report-like view, as seen below:
To print this report, select Print from the File menu.
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4. Elements
4.1

Elements

Elements are items that need to be scheduled onto breakdown sheets. You can
add elements to breakdown sheets from the Breakdown screen. However, if
you want to manage your elements, you should go to the Elements module.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 6 – Managing Elements, Part 1
To access the Element Manager, select the Elements button on the Gorilla
Toolbar:
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On the left-hand side of the screen, you will see all your Categories and related
Elements. To expand the Category to display all its related Elements, select
the Category:

If you click on the Props category, it
will expand to display all its related
Elements Æ

Select an element to display details about that element on the screen:
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4.1-1

Creating a New Element

To create a new element, select New Element from the File menu or select
the green add button next to the Category you want to add the element to.

You can select a Category from the list, and then enter the element name.

4.1-2

Deleting an Element

To delete an element, select the element, then select Delete Element from
the File menu.

When you delete an element, it will remove all instances of that element on all
breakdown sheets for the current schedule.

4.2

Element Tabs

By selecting one of the Element tabs, you can navigate to different parts of the
element.
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4.2-1

Breakdown Sheets Attached to Elements

To view or add breakdown sheets to an element, select the green add button in
the Scenes tab:

In the example above, the element “Broom” is attached to one scene, Scene 2.
To add this element to more breakdown sheets, click on the green add button.

This will show a window with all existing breakdown sheets. Select one or more
breakdown sheets to add them to this element, then click the Import button.
When finished, your screen might look like this:
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In the above example, the element “Broom” is attached to the Scenes 2, 4, and
12.

4.2-2

Art Gallery

The Art Gallery tab is where you can attach pictures to your elements. Pictures
can be in the .jpg or .png format. You should also make sure the image size is
not too large. The larger the size the more room it will take up in Gorilla.
To attach a picture to an element, select the Camera button and choose a
graphic from your hard drive.

You can attach up to 10 pictures for each element.
To navigate to a different picture, select the thumbnail of that picture.
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4.2-3

Linking Elements

Element Linking allows you to link one element to multiple elements. This
allows you to create a group of elements that you can attach to a breakdown
sheet all at once.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 7 – Managing Elements, Part 2
For example, let’s say you have a Cast Member that always wears a certain
uniform or carries the same tool. You can link all these elements together to
create a Link Group.
To do this, go to the Linked Elements tab.
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Select a Cast Member, in the example below, we selected, “Barney”. Every
time we see Barney, he is always wearing a Janitor Uniform and carrying a
plunger by his side. Let’s create a Link Group for these elements.
Select the green add button in the Linked Groups window:

Enter a name for the Link Group:

To attach elements to this group, select the green add button in the Linked
Elements window:

You can now “link” elements to this group. In the example below, the Barney
Group is linked to the elements: Janitor Uniform and Plunger.
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This means, that when the element: BARNEY is added to a Breakdown Sheet,
the elements Plunger and Fool Spattered T-shirt will also be added to that
Breakdown Sheet.

4.2-4

Relinking Elements

The Relink button allows you to attach linked elements to existing elements
already on breakdown sheets. So for example, let’s say the element BARNEY is
already on many breakdown sheets. Later on, you decide that this element also
needs the Janitor Uniform and the Plunger every time this element is
scheduled onto a breakdown sheet. After creating the Link Group and attaching
these elements to that group, you can select the Relink button:

This will allow you to attach the linked elements in the Link Group to all
instances of BARNEY on all breakdown sheets:

4.2-5

Rates & Blackout Dates

The Rates, Blackout Dates, and Day out of Days tab allows you to enter rates
for elements, enter blackout dates for elements, and enter Day out of Days
preferences for elements.
Rates entered here for an element will also allow that rate to be imported into
the budgeting module if you import the element into budgeting.
Day out of Days preferences can be entered here for each element which
affects how the element will appear on the Day out of Days report. (See next
section for an explanation of the DOOD report).
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You can enter blackout dates for an element here. You can then print out a
Blackout Dates report.

4.2-6

Day out of Days (DOOD)

To modify Day out of Days preferences for a particular element, do the
following:
Select the DOOD tab.
The Element Day out of Days Screen will appear, where the following
preferences can be set:
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Preferences for Elements
Preference
Allow Holds

Description
If checkmarked, when running a Day out of Days Report, this
element will hold for the number of days indicated in Days
Held before Drop.

Allow
If checkmarked, this element will drop and then pickup in the
Drops/Pickups number of days indicated in Days Held before Drop.
Drop to Use

Specify a number (by default set to 1) which will indicate
which drop to use if the element is eligible to be dropped more
than once.

Days Held
before Drop

Specify a number (SAG rules dictate 10-14) which specify how
many days an element is held before dropped.

Day out of Days Example
If the character MARY is scheduled to shoot on the following days:
04/01
04/02
04/05
04/11
04/24
And her element preferences are set to the following:
Allow Holds = x
Allow Drops/Pickups = x
Drop to use = 1
Days Held before Drop = 10
After running a Day out of Days Report, her report would like this:
4/1

4/2

4/3

4/4

4/5

4/6

4/7

4/8

4/9

4/10

SW

W

H

H

W

H

H

H

H

H

4/11

4/12

4/13

4/14

4/15

4/16

4/17

4/18

4/19

4/20

WD
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4/21

4/22

4/23

4/24
PWF

Explanation of above matrix:
On 4/1 Mary begins shooting, so her legend is SW which stands for START
WORK. She returns the next day, which is 4/2 so that box is tagged with W,
which stands for WORK. She does not return until 4/5, which is three (3) days
later. Since we are allowing HOLDS for Mary, we need to hold these days,
which are signified with an H. The next day she works is 4/11, which is 6 days
later. Since we do not attempt to drop her unless she is not working for 10
days, these days are also held. After 4/11, Mary does not work again until
4/24, which is also her last day of work. Since this span is more than 10 days,
we drop her on 4/11, signified with a WD (WORK DROP), and then have her
picked-up on 4/24, signified with a PWF (Pickup/Work/Finish).

4.2-7

Combining Elements

You have the ability to combine two elements together. This can be two Cast
Members, or any other elements from any other category.
Sometimes when importing a screenplay, a single character will come into the
schedule with multiple character names. This is because the writer might have
written different names for the same character throughout the screenplay. For
example, a character that is mostly named: BOB, can be written as ROBERT or
BOBBY in some scenes. If this occurs, then multiple Gorilla will read each as a
different character and import them as 3 different characters.
Also, a misspelled character (shown in the example below), can be fixed by
merging, or combining the misspelled character with the correctly-spelled
character.
To remedy this, you can use the Combine Element feature. Go to the Elements
module and find the primary element, for example: BARNEY and then select
Combine Elements… from the Schedule pull-down menu.
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Select the secondary character, for example: BLARNEY. This will combine the
two characters together, eliminating the secondary character, but moving all
the secondary character’s breakdown sheets to the primary character.

4.2-8

Locked Board ID’s

Every element can have a Board ID. This is used for multiple purposes. A Cast
Member Board ID is used to display that Cast Member on the Stripboard and
Scene/Cast Call Sheet reports.
An element in a non-Cast Member category (i.e.: Props), can be used on a Day
out of Days report to see which elements are scheduled for each day.
In any case, when Cast Members (Characters) are imported from a screenplay
or created within Gorilla, they are assigned a Board ID. All other elements are
not. You can manually enter a Board ID for an element or use the Repopulate
Board ID command (see below for an explanation).
You can lock a Board ID, by selecting the Lock Board ID checkbox for that
element.

4.2-9

Changing Board ID’s

Gorilla imports your screenplay and numbers the Board ID’s for your Cast
Members in alphabetical order. You can renumber your Board ID’s based on
occurrence of the character. So, for example, a lead character (the one who
has the most scenes), will automatically be given the ID: 1.
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To automatically change Board ID’s based on of occurrence, select Update
Cast Member Board ID’s… from the Schedule menu.

You have an option to keep the elements whose Board ID’s are locked
unchanged during this process, or to override locked Board ID’s and change all
Board ID’s for the selected Category.

4.2-10

Repopulating Board ID’s

You might want to enter a Board ID for elements other than Cast Members.
Gorilla gives you the option to manually enter a Board ID for each element, or
to automatically number your Board ID’s within each category starting from 1.

4.3

Attaching Characters to Actors

Characters can be attached to actors, transforming the actors into Cast
Members. To attach a character to an actor, do the following:
Go to the Elements module.

Select the Cast Member you want to attach an actor to, and then click on the
Actor Cast field on the Info tab:
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Either select an actor from the list, or create a new actor.

4.3-1

Removing Actors From Characters

If an actor is no longer playing a role, it is necessary to remove them from the
character.
Select the Actor Cast field:

You will see the following screen:
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Select Yes. You can then recast the role, or click Cancel to leave this Cast
Member uncast.

4.4

Attaching Rates to Elements

To assist with budgeting, it may be helpful to enter a daily or weekly rate
associated with an element. To attach a rate to an element, do the following:
Go to the Elements module, and select the Rates, Blackout Dates, & Day out of
Days tab.

You can enter up to 4 different rates for any element.

4.5

Categories

Every element must be attached to a Category. By default, Gorilla creates a set
of Categories that will suffice for most productions. However, you can add or
modify categories and attach elements to those categories.

4.5-1

Navigating through Elements

To view a list of Categories, select the Elements button on the Toolbar.
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On the left-hand side of the screen, you will see all the Categories created for
the current schedule.
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To see all the elements attached to a category, select the category. It will
open to see all the related elements for this category:

You can then select an element by clicking on it:

When you select an element, all detailed information will be available for that
element.

4.5-2

Modifying a Category

To modify a Category name, select Manage Categories from the Edit
menu.
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A list of Categories will
appear in a new window.
To modify a Category
name, select the edit
button. The only two
category names that
cannot be changed are;
Cast Members and Extras,
because they are used for
Scene/Cast Call Sheets
and other reports.
To delete a category,
select the red delete
button next to that
category name.
The numbers in the
brackets display how many
elements are attached to
that category.
To reset all categories for
the current schedule to
the default set, select the
Default Colors button.
To add a new category,
select the green add
button.
To edit the color and text
formatting of the category
name, select the edit
button next to that
category.

4.5-3

Rebuilding the Category List

Sometimes the list of categories that appear on the left-hand side of the screen
need to be rebuilt. This will occur on occasion when you add or remove
elements or categories. All this does is recompile the list of categories and
elements to display properly.
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If you select the Categories label below, and you do not see any categories or
elements below it, or the list of elements are incorrect, you need to rebuild
you elements list.

To rebuild the element list, select Rebuild Element List from the View
menu.

When rebuilding the element list, you have two options:

The first option should be attempted first. This will attempt to rebuild the
element list for the current schedule only.
If this option does not work, rebuild the element list again using the Full
Rebuild option.

-67-

4.5-4

Importing Elements from Another Source

Gorilla can import elements from a Word list, an Excel spreadsheet, or a
FileMaker Pro database.
Preparing the File
To import the elements properly, go to the source application where the
elements reside and prepare the data as follows:
In the figure below, a list of PROPS is being imported from an Excel
spreadsheet running on a Macintosh.

Prepare the elements in a single column. Each element should be on its own
row. Close the source application and return to the Elements Screen.
Select Import Elements …from a Text/Excel file from the File menu:
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Select the appropriate Category to import the elements into.

4.5-5

Importing Elements from Another Gorilla Schedule

Gorilla can import elements from another loaded Gorilla schedule.
Select Import Elements …from another Schedule from the File menu.

Select a schedule to import elements from:
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You will then be prompted to select a FROM and a TO category, as shown
below:
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5. Calendar
5.1

Overview

The Calendar Module is used to create production phases, shoot days, set call
times for cast and crew, and create meetings and post notes and important
dates on the calendar.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 9 – Shoot Days & Production Phases
To go to the Calendar module, select Calendar from the Gorilla Toolbar:

5.2

Production Phases

Production Phases can help spread a shoot across multiple weeks or months
with breaks between them. A separate production phase can be created for
each shoot even though that shoot is tied to the entire production. Production
Phases have the following additional benefits:
•

Ability to run many of the scheduling reports by production phase or by
project.

•

Ability to attach breakdown sheets to different production phases.

•

Ability to run a Day out of Days separately for each phase.

Important Notes There must be at least one production phase per
schedule. A production phase must have days attached.

-71-

One Phase:

On the left-hand side you will see Production Phases. In the example above
there is only one Production Phase. In the example below, there are two
Production Phases:
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Phases can be defined as Shoot Days or Non Shoot Days. If a Phase is defined as
Non Shoot Days, then none of the days attached to that phase can be a shoot
day. This is used for example, if you want to create a phase for Preproduction,
as shown in example below:
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In this example, notice the Phase Type is set to: Non Shoot Days. This means
that the dates 8/16/2010 through 8/31/2010 for this phase are designated as
Non Shoot Days.
You can use this phase to setup meetings, rehearsals, location scouts, etc.
In the example below, the phase: Principal Photography is flagged as: Shoot
Days.

In this phase, the days are Shoot Days and you can schedule breakdown sheets
to be attached to any of these days.

5.2-1

Creating Production Phases

In order to create a production phase select Create New Phase from the
File menu.
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You can name the phase anything you want.
Up to 5 phases can be displayed on the Monthly Calendar at a time, so you can
select which line (First, Second, Third, etc.) you want the phase to display. You
can also select a phase color and a text color (either black or white), and lastly
you must specify whether the days for this phase are Shoot Days or Non Shoot
Days.
Important Notes Although you are limited to only display 5 phases on a
monthly calendar view (see below for more info), you can create an unlimited
number of phases for any schedule.

5.2-2

Labels for Shoot Days/Non Shoot Days

Each day attached to a Production Phase can have many attributes. Each day
can have its own label (see below).
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To insert a label to a shoot day, select the field in the Calendar Label column
for that day. When you click on the Calendar button on the top right-hand side
of the screen:

You will go to the following monthly view of the calendar:

Where you will see the labels and the start and end dates for your phases.
To print this calendar, select the Print button on the bottom of the screen.

5.2-3

Attaching a Phase to a Breakdown Sheet

In order for a breakdown sheet to be scheduled on the stripboard, it must be
attached to a Production Phase. To attach a breakdown sheet to a phase, go to
the breakdown sheet by selecting the Breakdown button on the Toolbar:
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On the Breakdown Sheet select the Phase field:

You can attach the breakdown sheet to any phase that is flagged with the type:
Shoot Days. A Non Shoot Day phase cannot be used for breakdown sheets.

5.2-4

Moving Breakdown Sheets From One Phase to Another

You can use the same method described above to move a breakdown sheet
from one phase to another.

First select the Phase field on the breakdown sheet.
Then in the pop-up window, select the phase you want to attach to the
breakdown sheet. In the example above, we are moving the phase for the
selected breakdown sheet from Principal Photography to Second Unit.
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This will allow scheduling on that breakdown sheet on the stripboard for the
Second Unit Phase.

5.3

Shoot Days and Non Shoot Days

Each Production Phase can have days (either Shoot Days or Non Shoot Days)
attached to it. When a new phase is created, you are prompted to create days
for that phase including a start and an end date.

5.3-1

Modifying Days

You can modify the days attached to an existing phase, by clicking on the Note
button next to the name of the phase:

This will display the following screen:

To modify the start and/or end dates for this phase, select the Shoot Days tab
and enter a different Start Date and/or End Date.
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You can also push shoot days forward or backwards 1 day at a time or many
weeks at a time.

For example, if you want to move the entire shoot schedule out two weeks to
begin on 1/29/2012 instead of 1/15/2012, the best way to do this is to select
the Push Days pull-down and select 2 Weeks:

This will ensure that all your off days, crew call times, cast call times, etc. will
remain intact and the entire schedule will move 2 weeks forwards or backwards
depending on the Direction selected.
If you enter new dates in the Start Date and End Date fields, this will also
change your shoot days, however, off days and other crucial information
entered will be cleared since you are creating new dates.
Using the Push Days option is a much better way to move shoot days forward or
backwards while keeping your schedule intact.

5.3-2

Days Off, Travel Days, & Holidays

You can specify days off, travel days, and holidays on for any day.
To set a Day Off, select the Day Off field for that day on the Production Phase
tab view of the Calendar.
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A Day Off will not be able to be scheduled for a production day. In other words,
breakdown sheets will not be able to be attached to that shoot day on the
Stripboard.
A day marked as a Travel Day can either be a Shoot Day or a Non Shoot Day. In
the example below the Travel Day is not specified as a Day Off.

In the example below, however, the Travel Day is also specified as a Non Shoot
Day.

Holidays are treated just like Days Off. They are not considered a Shoot Day.
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5.3-3

Automatically Set Off Days

You can globally set off days for your entire schedule by selecting Set Off
Days… from the Edit menu.

The above example will go through the entire phase and set Saturdays and
Sundays as off days.

5.3-4

Setting Crew and Cast Call Times, Notes, Call Sheet
Info, and Daily Production Report Info

Crew and cast call times, notes, call sheet info, and daily production report
info can be set for each day by clicking the appropriate column for the desired
shoot day.
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Cast Call Times
To set cast call times, do the following:
Arrange the stripboard, and make sure that there is an end-of-day break at the
end of the stripboard.
On the Calendar, select the Call Sheet button for the Shoot Day you want to
enter Call Times for. Select the Cast Call Times tab:

Set individual call for Makeup and Call Time.
Call Times will be printed on Scene/Cast Call Sheets only if they are entered
here.
Exhibit G
The Screen Actors Guild may require an Exhibit G for each day of shooting. To
enter information in the Exhibit G from the Cast Call Times Screen, select the
SAG button for that Shoot Day.

Select that Exhibit G button for the Actor you want to enter Exhibit G
information for.
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This is where you can enter specific Call Times, such as Makeup, Report On Set,
Dismiss On Set, Dismiss Makeup/Wardrobe, Meal Times, Travel Times and Other
Remarks.
Crew Call Times
Crew Call Times can also be entered in the Calendar. However, unlike Cast Call
Times which is dependent on the shooting schedule, scheduling crew must be
done manually. Gorilla makes it easy to create crew members and attach them
to shoot days. Crew members are created in the Contacts module. You can
attach them to Shoot Days from either the Contacts module or the Calendar.
This section will cover attaching them from the Calendar.
To attach crew to a Shoot Day, select the crew button for the Shoot Day you
want to create crew for.

You will see the following screen:

The mini-calendar on the top allows you to navigate to different shoot days.
To attach a single crew member to a shoot day, click on the add button.
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You will see a list of all crew available for this schedule.
** If a crew member is not in this list, you need to add the crew member to the
Contacts module for this schedule. See Crew in the Contacts module for more
information on how to do this.
To add a crew member to this shoot day, select the checkbox next to the Title
and Name of the crew member.
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When you close this window, you will see the selected crew member(s) listed in
the Crew Call Times tab:

The Call Time assigned to the crew member will be the default Crew Call Time
for that Shoot Day. You can change individual crew call times, by selecting that
call time for that crew member.

To remove a crew member from a shoot day, select the delete button next to
that crew member.

This DOES NOT delete the crew member from the Contacts module!
It only removes the assigned crew member from the selected shoot day.
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You can also attach multiple crew to a shoot day by clicking on the Import
Crew button.

This will import all crew from the Contacts module for this schedule and attach
them to the selected shoot day.

You can them customize the day by removing any crew members you do not
want to schedule for that shoot day.
To remove all scheduled crew for the selected shoot day, click on the Remove
Crew button.

Notes
Notes can be entered for each shoot day.
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Notes will be printed on a variety of reports, one of which is the Scene/Cast
Call Sheet.

Call Sheet Info
If you click on the Call Sheet button next to a shoot day, you can enter various
information for the shoot day that will appear on your Scene/Cast Call Sheet.
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You can enter weather information, crew parking, nearest hospital,
atmosphere, stand-ins and special instructions on this screen.
In the Get Weather field, you can enter a URL that goes to a web page to
display the current day’s weather for your location. There are many such web
pages. You can find one that suits your specific location and needs.
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Daily Production Report
The Daily Production Report (DPR) is an industry standard post-shoot-day
report. Enter figures from the last day of shooting here.
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6. Stripboard
6.1

Overview

The stripboard is used to rearrange scenes into shooting order.
Important Note: Before rearranging strips on the stripboard, complete
the following: a) Create a production phase, b) Enter all breakdown sheets, c)
Create shoot days, including days off and holidays.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 11 – Stripboard, Part 1

To access the Stripboard, click the Stripboard on The Gorilla Toolbar.

Upon entering the Stripboard for the first time, you will be prompted to create
a board:
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Gorilla requires that board have a name and be attached to a Production
Phase.

When you select a production phase to be attached to a board, only shoot days
that are attached to that phase will be available to be scheduled on that
board.
To see which shoot days are attached to a phase, go to the Calendar and select
a phase:
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When you create a board, all breakdown sheets attached to the production
phase will appear as colored strips.
The Shoot Days associated with the Production Phase will appear at the bottom
of the board.
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6.1-1

Drag and Drop Strips

To move a strip, click on it and drag it up or down the board.
The way the Stripboard works is any strip or strips above a day break strip is
scheduled for that day. So if you were to drag the first day break to above
Scene 4 (see below), this would indicate that Scenes 1, 2, 3, and 4 are
scheduled to be shot on February 1, 2012.
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Notice that the total page count totals the page count of the strips above it.

6.1-2

Moving Multiple Strips

To move multiple strips, select the strips holding down the SHIFT key, then
move the strips. An indicator will show that you are moving Multiple Strips:

6.1-3

Moving Non-Contiguous Strips

To move multiple strips that are not contiguous on the board, select the Apple
key (Macintosh) or Control key (Windows) while selecting the strips, then move
them to the desired location.

The highlighted strips above (Scene 7, 8 and 11) were all selected holding down
the modifier keys (Apple for Macintosh, Control for Windows).
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6.1-4

Cutting & Pasting Strips

You can also cut and paste strips using the buttons on the Stripboard Toolbar.

To cut a strip, (or strips), select them and select the Cut Strip(s) button.

The strip(s) selected will grey-out with a diagonal line through it, indicating
that this strip is waiting to be pasted somewhere on the board.
Move up or down the board to the desired location, and select either the Paste
After or the Paste Before button to move the Cut Strip(s) to the new location.

6.1-5

Sorting Strips

To sort the board automatically, select the Sort Strips… button on the
Stripboard Toolbar.

This will allow you to sort the board by up to three different sort criteria.
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Select the sort options you desire, then click on the Sort button.
The new sort will overwrite your existing board and unless you saved your
board before sorting, there is no way to retrieve your board.
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Explanation of the Default Sort Orders
Order

Description

Estimated
Time

Sorts by the field Estimated Time on the breakdown sheet.

I/E

Interior or Exterior field on the breakdown sheet

D/N

Time of Day (Day/Night/Morning/Afternoon, etc.)

Location
Name

This will sort by the physical location of the scene. This feature
works in conjunction with the Locations Module. Locations must
be attached to each breakdown sheet for this to work.

Page Count

The page count on the breakdown sheet

Set

This is the set description entered or imported on the
breakdown sheet.

Scene No.

Scene Number entered or imported onto the breakdown sheet.

Sheet No.

Sheet Number entered or imported onto the breakdown sheet.

The default sort orders help to start ordering strips in a way that will make
sense for a particular project. For example, to shoot all the scenes together
which are going to take place at one location (i.e STEVE’S HOUSE), sort by
location first. On the other hand, to shoot in screenplay order, sort by the
SCENE NO., and then begin to custom sort the strips.

6.1-6

Auto Day Breaks

When you create a board, all the day breaks (or Shoot Days) automatically
appear at the bottom of the board.
You can automatically populate you board with day breaks based on a per page
ratio. In other words, if you want to schedule your board by shooting 5 pages
per day, you can use the Auto Day Breaks feature to insert a day break after
every 5 pages of breakdown sheets.
Select the Auto Day Breaks button on the Stripboard Toolbar to access this
feature.
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You will be presented with the following screen:

Here you can specify how many pages (including /8) you want to schedule for
each shoot day. If you deselect the Push overage to next day, this will
maximize each day with any overage of the page count specified.
By using the Sort Strips feature in conjunction with the Auto Day Breaks
feature, you can quickly have a workable board.

6.1-7

Boneyard

The Boneyard is where you place strips and day breaks you are not sure what to
do with. It is a “holding area” where you can temporarily place strips.
The Boneyard is positioned at the very end of the board.

Any strip positioned below the grey Boneyard strip is not scheduled. You can
move a strip to the Boneyard by dragging it there, or by selecting a strip (or
strips) and then selecting the Send Boneyard button on the Stripboard Toolbar:
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To move a strip or strips out of the Boneyard back onto the board, simply drag
it to the board above the Boneyard strip.
You can also move the Boneyard strip. If you move it up, any strip or strips
below it will not be scheduled.

6.1-8

Unscheduled Area

As explained earlier, every strip above a day break strip is scheduled. If a strip
is in the Boneyard it is not scheduled, but in a holding area. If you position a
strip below the last day break and above the boneyard, it is considered:
Unscheduled, and will appear as shown below:

In this scenario, Scene 18 is not attached to a day break strip. It is also not in
the Boneyard. It will not appear on any scheduling reports.

6.1-9

Banners

A banner is a note that can be placed on the Stripboard. This is useful for
labeling a set of strips.
Adding a Banner
To insert a banner on the Stripboard, do the following:
Select a strip and click on the Insert Banner button on the Stripboard
toolbar.
Enter text for the banner.
The banner will appear on the stripboard with a brown color, as shown below:
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Modifying a banner
To modify the text of a banner, do the following:
Double-click the text field in the banner strip and enter the new text.

Moving a Banner
To move a banner strip, move it just as if you would move any other strip.
Removing a Banner
To remove a banner, click the desired banner and select Delete Banner from
the Stripboard pull-down menu.

6.1-10

Schedule ID’s on the Stripboard

When viewing and printing stripboards, Board ID’s for cast members are
displayed for each strip indicating that the cast member related to that Board
ID is in that scene or scenes.

6.1-11

Selecting Colors for the Stripboard

To modify the colors for the strips, select Stripboard Colors from the Edit
menu.
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The stripboard is preset with the following color scheme:

Strip colors are determined by the combination of the time of day the scene
takes place and whether the scene is interior or exterior.
To change a color for a strip, select the box from the grid. A color palette
window will appear. Select a color from the selection of colors and select the
Apply button.

-102-

To change the text color for a color, select the small box with the letter and
number inside the colored box:

This allows you to change the text color for the strip color to either black or
white. A white text color against a dark color makes it easier to view the text
on the strip.
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To restore the default colors, click the Default Colors button.
To customize the name of the label, click on the label and then modify the
name:

You can do this for the INT/EXT labels or the DAY/NIGHT labels.

6.1-12

Printing the Stripboard

To print your stripboard, select Print from the File menu and select
Production Reports from the Select a Module window and then Stripboard from
the Select a Report window.

6.1-13

Saving the Stripboard

To save your stripboard, select Save Board from the Stripboard toolbar.
If you close the Stripboard without saving, you will see the following message.

Further, if the name of the board is in red (as shown below), the current board
has not been saved.

If the name of the board is in black, then the current board is saved.
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7. Contacts
7.1

Overview

Gorilla’s Contact module allows you to create all your contacts for your
projects. This includes actors, crew, agents/managers, other contacts and
companies.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 17 – Contact Manager Basics

To access the Contact module, select Contacts from the Toolbar.

The options within the Contacts module are:
All Contacts – This is where you manage all your contacts and attach them to
categories.
Actors – This is where you can manage actors.
Crew – This is where you manage crew.
Agents/Mgrs – This is where you manage agents and managers.
Companies – This is where you can create and manage companies and other
contacts.

7.2

All Contacts

A contact record is created here. Once created you can attach the contact to
one or more of three categories: Actors, Crew, Agents/Managers.
You can also enter multiple addresses and phones/e-mails for each contact
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7.2-1

Creating a Contact Record

To create a contact record, select the All Contacts button on the Toolbar to go
to the Contact Manager.

Select New Contact from the File menu:

This will create an empty contact record.
After you enter a name for this contact, you can create an address by clicking
on the green add button above the Address window:
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Gorilla allows you to enter multiple addresses for each contact. If you want to
add a second address to this contact, select the green add button again:

To delete an address from a contact record, select the red delete button.
To add a phone/fax/e-mail to a contact record, click on the green add button
above the Phones window:

Select a phone type in the pop-up list that appears:
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For phones, you do not have to enter dashes. Gorilla will enter them for you.
Similar to addresses, a contact records can have multiple phones and e-mail
addresses attached to it.
If you select the checkbox next to a phone or e-mail, that will identity that
entry as the default entry which will appear on reports for that contact record.

7.2-2

Attaching a Company to a Contact Record

In order to attach a Company to a contact record, click in the Company field:
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A pop-up window will appear displaying all created companies:

To attach an existing company to the contact record, select the company
name.
To create a new company, select the green add button.

7.2-3

E-Mail Current Record & Groups

To send an e-mail to the currently selected contact, select E-Mail Current
Record from the E-Mail menu:
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This will open your default E-mail application (Outlook, Entourage, etc.) and
place the e-mail address of the current contact record in the Send To: field.
Make sure that your contact record has an e-mail addresses attached to their
record.
To e-mail a group of contacts at the same time, select Setup E-Mail
Groups from the E-Mail menu:

In the E-Mail Groups screen, create a new group by selecting the green add
button.
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In the New Mail Group Name, enter a unique name for the group of contacts
you want to create.
If you select the Actor, Crew, or Agent/Manager button, then all contact
records from that category will automatically be attached to the newly created
mail group.
When you return to the E-Mail Groups screen (see below), you can add or
remove a contact from the e-mail group by selecting the checkbox next to their
name:
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At the bottom of the screen, select either Chevrons or Commas for the
separator required for your e-mail application.
Once all contacts are checkmarked, select the Send Mail button.
This will open your default E-mail application (Outlook, Entourage, etc.) and
place the e-mail addresses of the e-mail group in the Send To: field. Make sure
that your contact records all have an e-mail addresses attached to their record.

7.2-4

Attaching a Contact Record to a Category

Every contact record can be attached to one or more of the three categories
shown below:
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7.3

Actors

In order to attach a contact record to the Actor category, select the Actors
button for the contact, as shown above.
You will see the following pop-up window. To disable this message, select the
checkbox: Do Not Show category message.

7.3-1

Casting

When an actor is created and basic information is entered for that actor, that
actor is stored. This is a great way to store information about all actors that
have been interviewed, auditioned, or have sent in a resume and headshot.
However, that actor is not yet attached to a project. When an actor is attached
to a project and then a Character, he or she becomes a Cast Member.
To cast an actor in a project, click the Actor tab.
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Select the green add button:

Then select a Character to attach to the actor, by selecting the green add
button:

Notice that only elements that are in the Cast Members or Extras category can
be cast.
Characters that are greyed out are not available to be selected because they
are already cast.
You can create a new element (Character) by selecting the green plus button in
this window.
Once selected, the Character will appear on the Actor’s record:
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To remove this Character from the Actor record, select the red delete button.
This will not delete the Character from the Elements table, but only remove it
from the selected Actor record.

7.3-2

Removing Actor Records

To remove a contact from the Actor category, select the Actor button on the
Contact record.

This will remove the contact from the Actor category and will delete all actor
information from this record. It does not delete the Contact record.
Important Note: Gorilla will display a warning if the actor is attached to
a project.

7.3-3

Actor’s Headshot

To attach a headshot/photo to an actor record, select the Camera button on
the Casting tab:
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A new Photo window appears prompting you to create or select an image:

Select the green add button to import an image from an external source (your
hard drive or network drive).
You can add as many photos as you want to this area:
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To select one to appear on the actor record, select it.
You can also enter a label for the image (Headshot #1, Headshot #2, etc.)
To remove the image from the current actor record, select the red delete
button.

To permanently delete the image, select the red delete button from the list of
images, not on the actor record.

7.3-4

Actor Statistics

To enter actor statistics for each actor, select the Actor Statistics tab:
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7.3-5

Actor Representation

You can attach representation to actor records. Representation assigns contact
records from the Agent/Manager category.
Select the Representation tab and then the green add button.
A pop-up window will appear displaying all contact records that are attached to
the Agent/Manager category.

Select the Agent/Manager contact record.
That Agent/Manager will pop into the Representation window:
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You can attach multiple Agent/Manager contact records to a single Actor
record.
To remove the Agent/Manager record from the Actor record, select the red
delete button.

7.3-6

Credits & Biography

You can enter Credits & Biography information for the Actor in the
Credits/Biography tab:

7.3-7

Unions & Rates

If you purchased Gorilla’s Ratebook, you can attach a recent rate from any one
of 80 plus unions and nearly 9,000 labor rates.
Select the Union & Rates tab and select the green add button.
This will take you to The Gorilla Ratebook.
Select a union and then a position:
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The Ratebook window will close, and the union and associated rates for the
selected position will appear in the Union & Rates tab for the Actor record:

7.4

Crew

To create a crew record, from the Contact Manager select a contact record and
then click the Crew category button:

When you select a contact record to the Crew category, you will see the
following pop-up window. To disable this message, select the checkbox: Do Not
Show category message.
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To add crew information, such as titles and shoot days, select the Crew tab:

This is where you can attach a Title to this Crew member:

When you select a Title, an associated Department will also attach itself to the
Crew record.
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7.4-1

Managing Crew Titles & Departments

To manage Crew Titles and Departments, select Manage Crew
Titles/Departments from the Edit menu.

This is where you can add or modify crew titles and departments:
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Selecting a Crew Department on the left-side of the screen will display all
related Crew Titles on the right.
Selecting the green add button above the Crew Department window will allow
you to create a new Crew Department.
You can then attach Crew Titles to that Department by selecting the green add
button above the Crew Titles window.

To modify the name of a Crew Department or a Crew Title, select the edit
button next to the name you want to modify.
To permanently delete a Crew Department or a Crew Title, select the red
delete button next to the department name or title name.
To restore all default departments and crew titles, select the Default button.

Every contact record that is attached to the Crew category can have multiple
crew departments and crew titles.
There is always a “default” title and department attached to each Crew
record. You can also attach other titles and even different departments to a
crew record.
To attach a second, third, or fourth (or more!) title and department to a crew
record, select green add button on this tab:
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7.4-2

Attaching Shoot Days to Crew

To attach a Shoot Day to a crew record, select the Shoot Days & Crew Call
Times tab.
If you have more than one crew title attached to the crew record, you will be
asked to select the Position you want to attach a Shoot Day to:

Select the position.
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A pop-calendar will appear.
You will only be able to attach a calendar day that is designated as a Shoot Day
for the current schedule to the crew record’s position.
Select a day on the calendar designated as a Shoot Day:

On the Shoot Days & Crew Call Times tab, the shoot days that you select will
appear with the name of the title/position you selected earlier.
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You can change the Call Time for each individual day by selecting the Call Time
field for that Shoot Day:

The Total Number of Shoot Days appears on the bottom of the tab

7.4-3

Crew Representation

You can attach representation to crew records. Representation assigns contact
records from the Agent/Manager category.
Select the Representation tab and then the green add button.
A pop-up window will appear displaying all contact records that are attached to
the Agent/Manager category.

Select the Agent/Manager contact record.
That Agent/Manager will pop into the Representation window:
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You can attach multiple Agent/Manager contact records to a single Crew
record.
To remove the Agent/Manager record from the Crew record, select the red
delete button.

7.4-4

Credits

You can enter Credits for the Crew member in the Credits tab:

7.4-5

Unions & Rates

If you purchased Gorilla’s Ratebook, you can attach a recent rate from any one
of 80 plus unions and nearly 9,000 labor rates.
Select the Union & Rates tab and select the green add button.
This will take you to The Gorilla Ratebook.
Select a union and then a position:
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The Ratebook window will close, and the union and associated rates for the
selected position will appear in the Union & Rates tab for the Actor record:

7.5

Agents/Managers

To create an agent/manager record, from the Contact Manager select a
contact record and then click the Agent/Manager category button:

When you select a contact record to the Agent/Manager category, you will see
the following pop-up window:
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To add agent/manager information, such as company and agency information,
select the Agent/Manager tab. To disable this message, select the checkbox:
Do Not Show category message.

7.5-1

Importing Crew Members

Gorilla can import a list of crew members from Word® or Excel®. For this to
work properly, each record must be separated by a paragraph return in Word or
be in a different row in Excel. Prepare the data in the following order:
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If an entry does not exist for a certain category, leave that field empty with a
tab (Word) or an empty cell (Excel).
After preparing the data, do the following:
Select Import Contacts from the File Menu.

Select the type of file from the Show Available pop-down menu.
Locate the file to import.
Click Import.
Attach the new crew members the appropriate projects.

7.5-2

Exporting Crew Members

To export crew members, click Export Contacts.
Gorilla can export the crew data the following ways:
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•
•
•
•
•
•
•
•
•
•
•

Tab-Separated Text
Comma-Separated Text
SYLK
DBF
DIF
WKS
BASIC
Merge
HTML Table
FileMaker Pro
XML
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8. Locations
8.1

Overview

Gorilla’s Location module allows you to create locations for your projects.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 21 – Locations
To access the Locations module, select Locations from the Gorilla Toolbar and
then select the Manager button.

If you imported a screenplay, you imported SETS into your breakdown sheets.
For example:
INT. NORMAN’S LIVING ROOM – DAY
In the slug line above, “NORMAN’S LIVING ROOM” is the Set. It is not the
Location. The location is where you are going to shoot the scene. This could be
a sound stage at a studio, or an actual residence thousands of miles from where
the writer specified where the scene is supposed to take place.
Therefore, it is important to create physical locations which are places the
scenes are to be shot.

8.2

Creating a Location

To create a location, select New Location from the File menu:
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Enter a location name and all pertinent information for that location in the
fields specied.
When finished, click OK.
The next step is to assign/import/get photos for that location. This is not
required, but Gorilla allows you to attach as many photos you want for each
location.
You have a choice to “Add Photo” which allows you to import an image from an
external source (your hard drive, the web, a network drive), or to “Get Photo”
which opens up Gorilla’s Photo Library to select an existing image.

8.3

Accessing the Photo Library

To access the Photo Library, select the Get Photo button.

From the Category list, select a category and then select a image.
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After an image is selected, it will appear on the canvas for the current
location.
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To add a second image, select either the Add Photo or the Get Photo button on
the bottom of the canvas screen.

Select a category and then an image from within that category. The second
image will appear on the location canvas, as shown below:
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To rearrange the order of the photos, drag and drop them to the desired
location:

To edit the image or the image details, select the Edit button on the image.
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You can enter details for the image in the Details field. When you close the
window, the details will be seen on the image in the location canvas:

However, the amount of room allowed for this field is limited, as shown above.
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8.3-1

Edit Existing Image

To change the image of an existing location photo on the canvas, select the
Edit button on the image and then select the Add Camera button.

Select an image from your hard drive. This image will replace the existing
image.
Note: When sizing an image for the Locations module, it is best to resize the
image to approximately 320 x 420 pixels. Images can be saved in .png or .jpg
file format.

8.3-2

Delete Existing Image

To remove an image from the location canvas, select the Edit button on the
image and then select the Delete Camera button.
You will be presented the following warning, as shown below:

To remove this image permanently, select “Delete”.

8.4

Location Orderings

The Location canvas allows you to create images for your location and sort
them in any order. When you create a Location Group a default ordering for
the sort will also be created. It will be named: Default.
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You can change the name of this sort order group, by selecting the Edit button
to the right of the name.

Select the name: Default, and modify the name. Select the Close button.
The new sort order name will appear in the Pop-up menu:
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8.4-1

Creating a Second Sort Group

To create a second sort order group, select Save Ordering As… from the File
menu, or select the Save As… button on the bottom right-hand side of the
location canvas:

You will see the following dialog. Enter a name for the new sort order group
and click OK.
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Once a new sort order group is created, you can rearrange the order of the
images and then save them. This sort order group will not affect the first sort
order group. So it is possible to create multiple sorts for a single location.

8.4-2

Default Sort Order

Every Location Group can have a Default sort order group. Select the Default
checkbox below the sort order group name to make that sort order the default
group.

8.5

Flipping Through the Photo Library

To see all the images in the Photo Library, select the Photo Library button on
the location canvas or select the Library button on the Gorilla Toolbar.

Select a category from the category pull-down list:
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The related images for the selected category will appear in a flow-style record
browsing manner:

To flip through the images, select the image you want to view.

8.5-1

Hiding Photo Library Image

You cannot delete or remove photos in the Gorilla Photo Library that come preloaded into Gorilla. You can however, hide them so that they do not appear in
the Get Photo list of photos when you select an image for the location.
To hide a photo, select the image from the Photo Library and select the
Camera button with the dark cloud over it:
-143-

Similarly, to unhide a photo, select the same button again.

8.6

Modifying the Photo Library

You can store your own photos/images in the Gorilla Photo Library and access
them for any project.
Select the Photo Library button:

And then select the Edit button on the Photo Library screen:

You will be prompted to import a new image from your hard drive. Enter a
name for the image in the Image Name field:
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If you select the “Include this image in the Photo Library” checkbox, you will
be prompted to attach the image to a Photo Category.

The image will now be stored in the Photo Library.

8.7

Photo Library Categories

You can create custom Photo Library Categories for your photos. Select the
edit button next to the Select Category field.
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To create a new category, select the green add button.
After the category is created, you can attach photos to this category.

8.8

Scenes for Location

After you create a location, you can attach scenes from the Breakdown Sheets
module to the location.
Select the Scenes for Location tab:

-146-

To access the list of breakdown sheets for the current schedule, select the
green add button.

Select one or more breakdown sheets to attach to the currently selected
location.
When you click the Close button, you will see all the scenes selected attached
to the current location.

In the example above, Scenes 3, 5, 8, and 10 are all attached to the location
record.
If you click the Scene (for example, Scene 3), you will be taken to the
corresponding breakdown sheet.
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Notice that the location name is populating the Location field on the
breakdown sheet.
If you select List Breakdown Sheets from the Breakdown pull-down menu,
you will see a list of all the breakdown sheets:

Notice that the field Location is populated with Locations from the Locations
module.
Each scene (breakdown sheet) should be attached to a location.
This will ensure proper reporting on Scene/Cast Call Sheet reports and easier
sorting on the Stripboard.

8.9

Address & Map for Location

If you enter a valid address for your location, you can see a live Google Map of
that location.
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To make sure you have an address entered for your location, select the edit
button next to the name of the location in the location navigator.

In the pop-up dialog box, make sure you have a valid street address.

Click the Close button, and then select the Google Map tab:
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You must be connected to the Internet to receive data from the web.
The map information from Google Maps will appear on the tab.

In essence you are opening a web page within Gorilla. You can enter a new
address in the map search field and widen the window to see more information
on the screen.
Note: Changing the address here in Google Maps, does not modify the address
entered in Gorilla for your location.

8.10

Location Fact Sheet

For every location, it is imperative to know what facilities the location has for
your cast and crew.
The Location Fact Sheet tab allows you to enter electrical access, parking,
restrooms, light information, storage, makeup and wardrobe area and much,
much more for each location.
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9. Storyboard
9.1

Overview

The storyboard can help keep track of each shot needed to cover a scene. This
can be used for planning purposes, or to make sure that every shot has been
captured during production.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 22 – Storyboard, Part 1
To view the storyboard, click the Storyboard button on the Gorilla Toolbar
and select the Shots button.

The Storyboard screen allows you to select a scene from the Scene Navigator
and then attach shots to that scene.

In the example above, Scene 1 is selected in the Scene Navigator.
The shots attached to this Scene are shown in the Storyboard canvas.
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To rearrange the order of the shots, drag and drop a shot to the desired
location.

9.2

Shot Setups

When you first create a shot for a scene, Gorilla automatically creates a Shot
Setup record for that scene.

Every scene must have at least one Shot Setup. To edit the details of the setup,
select the edit button as shown above.
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You can enter setup notes and import a layout of the setup. This can include
camera positions and objects to be framed for the setup.
Once a Setup Group has been created, you can begin adding shots to the scene.

9.2-1

Adding Shots

To add a shot to the current setup, select the Add New Shot button.

If a Shot Setup is not created for the selected scene, you will be prompted to
create one:

Click OK and a new Shot Setup will be created.
You will be prompted to select a Shot Category.
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All shots are categorized in categories.
Select a Shot Type. The shot types that are pre-set into Gorilla are as follows:
Category

Shot Type

Basic

Master
Full Shot
Medium Shot
Medium Close-Up
Close-Up
Extreme Close-Up
Over the Shoulder
Establishing
Establishing Crowd
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Camera Techniques

Pan
Pull Focus
Sleep Over
Pass Out

Composition

Action – Combat
Hand-Held
Interview
Tilted
Master Social

Crane

Rise Up
Crane Down
Crane Up
Search Up
High Angle
Crane Up Entrance

Editing

Split Screen
Montage
Superimposition

Moving/Tracking

Dolly Down
Dolly Up
Fly Over
Pull Back Retraction
Pull Back Reveal
Spin Around
Action – Chase
Dolly Tracking Shot
Zoom
Push In
Draw Out
Open Up/Reveal

Perspective

P.O.V.
P.O.V. Object
Bird’s-Eye View
Shadow
Voyeur
Object POV
Screen
POV – Bug
Dark Voyeur
Portal
Underwater POV
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Special FX

Slow Motion
Animation
Rear Projection
Green Screen

Gorilla will create the shot type and place a frame on the Storyboard canvas:

9.2-2

Editing the Shot Type Picture

The image entered for the shot type is an image from the Gorilla Storyboard
Library. You can use this image to represent the shot type, or import your own
image from an external source.
Select the Edit button on the shot to see details for this shot.
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To import a custom image, select the Use Custom Image button. You will be
prompted to import an image from your hard drive.
The image you select will replace the default shot type image for the scene
and will appear on the Storyboard canvas.

9.2-3

Detail Information for Shot

You can enter information for the shot in the Edit Shot screen.
Select the Edit button on the shot:

On the Edit Shot screen, you can enter a short description in the following
field:

The information you enter in this field can appear on the shot in the Storyboard
canvas if you select the “Display short description” checkbox on the bottom of
the previous screen.
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The information entered in the short description field is limited on the shot to
two short lines, as shown above.
If you want to enter detailed information for the shot, select the edit button
on the Edit Shot screen:

On the screen that appears, you can enter detailed information for that shot. If
detailed information is entered, it will print out on Storyboard reports.

9.2-4

Start and End Times for Shot

You can enter Start and End times for each shot. This is for scheduling purposes
if you want to organize your days’ shots.

At the end of the day, you can log the status of the shot with either Shot or Not
Shot.
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9.2-5

Resizing the Storyboard Canvas

By selecting and moving the slider at the bottom of the Storyboard canvas, you
can change the size of the shots to take more or less room on your screen.

9.2-6

Add Existing Shot to Setup

Many times when shooting a scene, you need to shoot a shot and then shoot a
different shot, then perhaps shoot the first shot type again. For example, it is
not uncommon to have a shot list as follows:
1. CU: Gun
2. FULL SHOT: People walking in alley
3. CU: Hand Loading Gun
The first and the third shots are both CLOSE-UPS.
By selecting the Add Existing button, you can quickly insert an existing shot
type on the Storyboard canvas.

9.2-7

Removing a Shot from the Setup

To remove a shot from the Storyboard canvas, select the Edit button on the
shot.
Select the Remove Shot button.

-159-

You will be presented with a dialog that warns you that this shot will be
removed from all orderings for this scene.

9.3

Sort Orderings for Setups

You can also save different sort orderings for each setup.

To create a new sort order group, select the Save As… button.

You will be prompted to enter a name for the new sort order group.
After it is created, you can toggle back and forth between the sort order
groups:

If you rearrange shots on one sort group, it will not affect the sort for the
second or more sort order groups.
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9.4

Attaching Elements to Shots

Since the Storyboard module is linked to the Scheduling module, you can attach
elements to your shots.
If you scheduled your breakdown sheets and attached elements to scenes (Cast
Members, Props, Set Dressing, etc.), you can then attach those elements to
specific shots.
So for example, if you attached Cast Members, Set Dressing and other elements
to a scene, but in one shot you only need a CLOSE-UP of an object, you can
specify that in the Edit Shot screen.
Select the Edit button on the shot:

You will see the following screen. Select the green add button on the Elements
tab:
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All elements that are attached to the scene in the Scheduling module (on the
Breakdown Sheets screen) will appear.

Select the element you want to attach to this shot.
In the example above, there is a prop: GOLD COINS.
After you select Close, the element will appear in the list of elements for the
selected shot.
Note: If the element you want to add to the selected shot does not appear in
the list of elements for the scene, you need to go to the breakdown sheets
module and add the element there before you add it to the shot.

9.5

Adding Equipment & Vehicles to Shots

To add Equipment and/or Vehicles to a shot, select the appropriate tab and
select the green add button.
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Select the equipment line item or the vehicle line item from the list to add it
to the shot.
You can also select the green add button on this screen to add a new piece of
equipment or a new vehicle to the list.
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10. Budget
Gorilla comes preinstalled with sample budgets which can be customized. The
Budgeting Module also has some powerful features like globals, fringes, groups
and much more.

Video Tutorial Available for this lesson! Visit:
http://www.youtube.com/user/junglesoftwaretv
Lesson 24 – Loading a Budget Sample/Template

To launch the Budget module, select the Manager button from the Gorilla
Toolbar.

10.1
10.1-1

The Budget Manager
The Budget Window

Below you will see the bottom half of the Budget Manager screen.
All budgets shown in this list are loaded budgets. Just click on the Go To button
to go to the Topsheet of the selected budget.
To load a new budget into Gorilla, select the green add button:

You will be presented with the following dialog box:
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To a create a New budget from scratch, select the New button.
To load an existing budget that is already saved on your hard drive or load a
sample or template, select the Load button.

10.1-2

The Load Button

Selecting the Load button will show the following screen:
Notice there are three tabs: My Budgets, Templates, and Samples.
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My Budgets:

The budgets in this window are located in the My Budgets
folder. The default path for this folder is:
Gorilla 5/Gorilla Version/Saved Budgets/My Budgets.
If you move a budget to this folder and launch Gorilla, you
will see the budget on this tab.
To load a budget from the My Budgets folder into Gorilla,
select it. It will load and then appear in the Budget
Manager window.

Templates:

The budgets shown on this tab are template Independent
and Studio budgets that you can load into Gorilla. All
template Studio budgets do not have expense line items
(numbers/rates).

Samples:

The budgets in this window are Independent and Studio
samples that you can load into Gorilla. All sample budgets
have Category and Account line items and Detail line items
(numbers/rates).
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To load a budget that is not in any of these lists, select the Load Other…
button.

10.1-3

Linking a Budget to a Schedule

You can link a budget to an existing schedule. When you load a budget, you will
be prompted with the following dialog:

Linking a budget to a schedule will allow you to import items from Scheduling,
such as Props, Crew, and more into detail line items of your budget.
Selecting the Link button, will display the following screen:
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If desired, select a schedule from the list of schedules. If you do not want to
link the budget to a schedule or want to do it later, select Cancel.

The name of the schedule will appear in the Budget Manager if the budget is
linked to a schedule.
What this means is that items from the linked schedule can be imported into
the budget. This is explained in detail in Linking Scheduled Items on the detail
level of the budget.
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10.1-4

Saving a Budget

Gorilla saves your work as you go. If you quit Gorilla and do not save your
budget, when you open Gorilla the next day you budget remains intact.
However, it is a good idea to save your budgets outside of Gorilla for backup
purposes and in case of a software or hardware problem.
To save a budget, select the Save button on the budget line, as shown below:

You will see the following dialog:

If the Automatically save to My Budgets folder checkbox is selected, when you
select OK to save the budget, it will automatically be saved in you’re my
Budgets folder which is by default, located in your Saved Budgets folder.

Budgets are saved with the .grb file extension and are FileMaker 11 data files.
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Although they can be opened with FileMaker 11, the proper way to load a
budget back into Gorilla is to use the Load Budget command explained earlier.
If you de-select the Automatically save to My Budgets folder checkbox, you
will be prompted to save the budget somewhere on your hard drive.
If you select the Save as Template checkbox, this will save your 1st and 2nd
level budget items (category and accounts), but not your detail or 4th level line
items, so you can use the saved file as a template for other projects.
Any changes you make to the budget after you save it in this manner, will not
be saved to the budget file on your hard drive unless you save it again.

10.1-5

Deleting a Budget

To remove a loaded budget from the Loaded Budgets tab, select the red delete
button on the budget line:

This will remove the budget permanently from Gorilla. You can load it again
only if you have saved it previously in your My Budgets folder or from another
location where it is saved.

10.2

The Topsheet

To load a budget, click on the Go To budget button:

This will take you to the Topsheet.
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The Topsheet is a summary of your budget. In the above example, this is a
budget sample with numbers.

10.2-1

Navigating the Topsheet

The Budget Toolbar is used to navigate to different areas of the budget.

The greyed out button tells you where you are.
To navigate to the Accounts level, do one of the following:
Method A:
Click on the Accounts button on the Budget Toolbar.
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From the list of accounts, select an Account to go to.
METHOD B:
Click on a blue arrow next to the Category you want to see Accounts for.

Selecting the Command key and clicking on the blue will open a new window
for the Account level. See below how the 5500-00 Account window is open on
top of the Topsheet window so you can view both windows at the same time.
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Adding a Category on the Topsheet
To add a category to the Topsheet, select the Insert Row button. If you want to
insert a row below an existing row, select the row BEFORE you select the Insert
Row button.

A new category line will be inserted BELOW the line you select.

Enter an Account Number for the new line item. Tab to enter a description for
the category.
The total on the right side of the screen will be empty because we have not yet
added any detail or expense line items for the category.
You can also insert a line on the topsheet, by selecting a category line item:
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And from the Edit menu select either Insert Row [Below] or Insert Row
[Above].

10.2-2

Deleting a Category from the Topsheet

To delete a category from the Topsheet, select the row you want to delete
then select the Delete Row button:

If there are related accounts or detail line items for this category, you will be
warned before the category is deleted.

10.2-3

Adding Category Notes

To add a note to a category, select row you want to add or edit a note for,
then select the Note button:

Enter a note in the field provided.
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You can also change the color of the text by selecting the Category Color
button.

You can also enter notes for the Section by selecting the edit button for the
section.

10.2-4

Sections or Production Totals

You can create a section break or a Production Total for a group of categories.
In the example below, the Section Name: TOTAL PRE-PRODUCTION sums up
the categories above it.

The totals appear on the right side of the screen:
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To insert a production total, select the category number where you want the
break to occur:

In the example above the SOUND category, or Line 10 was selected on the
Topsheet.
From the Edit menu, select Insert Production Total.

A new production total line will appear on the Topsheet named: UNTITLED
PRODUCTION TOTAL.
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At the end of the new production total, the sum of all categories above it will
be totaled.
To name the new production total line, enter the field and type a new name.
To commit the name, tab our exit out of the field.
To manage your production totals, select Manage Production Totals from
the Setup menu.

This will take you to a screen where you can manage your production totals.
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Here you can rearrange the order of the sections, remove them entirely, or
insert new sections.
If you delete a section here it will delete all accounts and expense line items
associated with that section.

10.2-5

Moving a Category

To move a category to a different position on the topsheet, select the category
number:

From the Edit menu, select Move Selected Row
…
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A new topsheet window will appear prompting you to select the category line
where you want to move the selected category to:

Select an account to move the selected account to.
When you return to the topsheet, the CAMERA category will be moved below
the selected category.

10.2-6

Contractual Charges or Percentages

A contractual charge is a percentage or a fixed amount that you can add to
your budget.
To create or insert a contractual charge, select Insert/Delete
Contractual Charge from the Edit menu.
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You will see the following screen:

To enter a percentage or a flat fee for an existing contractual charge, enter
the percentage in the percentage field or a monetary amount in the flat fee
field. Select the Insert at End of Budget checkbox to display the contractual
charge at the bottom of the topsheet.
Select the Insert button for the contractual charge to insert it on to the
topsheet.
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In the example above, the contractual charge Completion Bond has been
inserted on the bottom of the topsheet.
If you return to the Insert/Delete Contractual Charge screen, a red contractual
charge indicated that it is on the topsheet:

10.2-7

Find/Replace

Using the Find/Replace command you can search for a text string and replace it
throughout the budget.
To access the feature, select Find/Replace from the Edit menu.

You will see the Find/Replace dialog:
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Enter a search string in the Find field, then enter a Replace string in the
Replace field.
Select the Replace All button.

The Find/Replace command will find and replace the text string in the
Topsheet, Account, Detail and 4th Level fields in the budget.

10.2-8

Move Items Up/Down on the Topsheet

To move a category line item up or down on the topsheet, select the line item
and then select the Move Up or the Move Down button.

If you attempt to move a line up or down to a different section, that line item
will move to that new section.

10.2-9

Export Budget

To export a budget, select the Export… command from the File menu.
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You can select one of three options. Export the Topsheet, Accounts, or Detail
level.
The file output will be an Export (.xls) file.

10.3

The Account Level

The budget is divided into three tiers. They are:
Categories (Top Sheet)
Account Level (2nd Tier)
Detail Line Items (3rd Tier)
4th Level (4th Tier) – optional
Each topsheet category line item can have multiple account level items. So for
example, if you click on the blue arrow on a category line item it will take you
to the account level of the corresponding accounts attached to that category.

When you are in the Account level, the Budget Toolbar will grey out the
Account level, as shown below:

You can also tell you are in the Account level because the list of items that
appear will have the “Account” label.
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Each of the displayed accounts below to the topsheet category: CAST.

10.3-1

Adding a New Account

To add a new account to this category, select the row you want to insert the
row under and then select the Insert Row button.

A blank account line item will appear BELOW that selected row.

If you have a naming convention, enter the proper Account ID and the name of
the account on the new line.
The Total for Account on the right-hand side of the screen will be empty,
because this is a new account.

10.3-2

Deleting an Account

To delete an account, select the row you want to delete, and then select the
Delete Row button.
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When deleting an account, all related detail line items will also be deleted.
This cannot be undone!

10.3-3

Duplicating an Account

To duplicate an account and all its related detail line items, select the row you
want to duplicate, then select the Duplicate button.

10.4

The Detail Level

The Detail level of the budget is where you enter rates and amounts for the
accounts.
To go to the detail level for an account, select the blue arrow for that account:

This will take you to the detail screen:
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10.4-1

Inserting a Detail Row

To add a detail line item to an account, do the following:
a. Select the Insert Row button.
b. Select the Insert Row [After] from the Edit menu:

Enter a description for the detail line item:

Required fields to be entered are: Amount, X, and Rate, as shown below:

The calculation is: Amount multiplied by X multiplied by Rate = Subtotal.
In the example above: 3 x 1 x 1,500 = 4,500.

10.4-2

Deleting a Detail Row

To delete a detail line, select the row you want to delete, then select the
Delete Row button.

10.4-3

Blocking a Detail Row

To block a detail line, select the green checkbox next to that line item:
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This will block the subtotal for this detail row in all reports.

This allows you to keep the row and all items attached to it, but temporarily
block it.
To unblock a detail row, click the red x for the detail row:

10.4-4

Showing/Hiding Columns

To maximize screen space, you can show or hide different columns on the
detail level, allowing you to work with only the columns you need and avoid
clutter.
The show or hide a column, select the appropriate button as shown below:

You can show or hide the following columns:
Location, Set, Agg %, Fringes, Currency.
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10.5

Globals

A global is a name value attached to a numerical value that you can use
throughout your budget.
If you set up your globals properly, you can quickly modify that value
everywhere the global has been entered in your budget by modifying the
global.

10.5-1

Setting up Globals

To setup globals from the Setup menu, select Global Management.

Or select Globals from the Globals, Fringes, etc. Toolbar.

Global Groups allow you to group a number of globals into a single group for
easy management. Global Groups can also be saved and loaded into other
Gorilla budgets.
When you first enter Global Groups a Default Global Group will be created, but
no globals are attached to that group.
To create a global for the selected Global Group, select the green add button
above the Globals window:
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Creating globals here will attach them to the selected Global Group above.
Select the green add button and create a global.

Enter a short name for the globals (2 or 3 characters), a description, and a
value for the global.
In the examples above, we created a global called: SD, which stands for Shoot
Days. The value for this global is 25.
This means that if you enter SD in a global field on the detail level for a line
item, the corresponding value: 25 will appear for that unit.*
* The global must be activated into the budget to become active (see next
topic).

10.5-2

Activating Globals into the Budget

When you first create a global it is not automatically active into the budget. A
checkmark over the globe indicates that the global is active into the current
budget.
To activate a global into the budget and make it available for use, select the
globe under the Activate Global column.
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10.5-3

Loading a Global Group into the Budget

You can also load an entire Global Group into the budget. From the Global
Groups list, select the Load button for the Global Group you want to load:

All globals that are in that Global Group will be loaded into the current budget.

10.5-4

Saving a Global Group

You can also save a Global Group to your hard drive and use it for other
budgets. To save a Global Group, select the Save button:

By default the Global Group will be saved in the My Globals folder in your
Saved Budgets Folder.
Global Groups are saved with a .glo extension.

10.5-5

Changing File Path for My Globals

By default, all saved Global Group files are saved in the My Globals folder
which is located in the Saved Budgets folder.
You can change where you want this folder to reside, or you can deselect the
checkbox and save your Global Group save files anywhere on your hard drive.
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If you deselect the Automatically save to My Globals folder checkbox, you will
be prompted to choose a location to save your Global Group save files.
To change the file path of the My Globals folder, select the footprint button.

10.5-6

Using a Global

To use an existing global, go to the detail line item:

Select the globe button on the Amount, X, or Rate columns, depending on
where you want to use the global.

From the above screen, select an existing global.
Notice how the description indicates that you are going to attach a global for
the AMOUNT field for the line item: Principals.
After you select a global, the Globals screen will close and you will be taken
back to the detail screen.
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Notice the the value 200 pops into the Amount field replacing the value that
was in there previously. Also, notice that the globe button now has a
checkmark over it indicating that this value is a global value.
If you manually change this amount to a different value, it will override the
global value.
If you go to the Globals set-up and change the value of the SD global from 25 to
30, it will change the value throughout the budget of the SD global to the new
value of 30.

10.6

Fringes

A fringe is a percentage or a flat fee that you can attach to a detail line item.

10.6-1

Setting up a Fringe

To set up a fringe, select Fringe Groups from the Setup menu:

You will be taken to the Fringe Groups screen:
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When you create a fringe, it is automatically attached to a Fringe Group. You
can attach multiple fringes to a Fringe Group.
Fringe Groups can be saved and imported into any budget.
To create a fringe, select an existing Fringe Group. Select the green add button
as shown above.
Enter a fringe name.

A fringe can be a percentage or a flat rate.
If the fringe is a percentage, select Percentage in the Type column and enter a
percentage (in decimals) in the % column.
If the fringe is a flat rate, select Flat Rate in the Type column and enter a
value in the Flat Rate column.

10.6-2

Activating a Fringe

To activate a fringe, select the globe button under the Active column. The
selected fringe will now be active in the current budget.
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10.6-3

Adding a Fringe to a Detail Line Item

To attach a fringe to a detail line item, select the percent button in the Fringe
column:

The View/Apply Fringes screen will appear:

Only fringes that have been activated in the Fringe Groups screen will be
displayed here.
To attach a fringe to the line item, select the checkbox “Attached”.

The total amount of the fringe will appear in the Total column.
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To attach another fringe to the same detail line item, select the fringe button
for the detail line item:

In the View/Apply Fringes screen, select the fringe to attach to the detail line
item:

You can attach any combination of fringe to a detail line item: Percentage or
Flat Rate.

10.6-4

Fringe Benefits by Flat Rate per Unit

To create a flat rate fringe, you must enter the Unit for the fringe. Units are
explained later in the Units section.
In short, a Unit is defined as a value attached to a key. For example, the Key
“H” stands for the unit Hour and is given the value: 1.0.
Below is an example of a flat rate, Other SAG Union Dues, given the flat rate of
75.00 with a Units entered in Hours.
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This means that if the amount entered is 1, the fringe will result in 75.00. If
the amount entered is 2, the fringe result will be 150.00, and so on.
If the Units entered were DAYS, and the value in Units for Days = 12 (defined in
Units) and the Amount entered = 2, then the result for the fringe would be
different:
Result: 2 (Amount = 2) x 75.00 (Flat Rate) x Days (12) = 1,800.00.
In the example below, this would be the result if the flat rate fringe = 75.00
and the Units entered is H = Hours and the value in Units for Hours = 1.0.

In order for Fringe Benefits by Flat Rate per Unit to work you must enter a Unit
for the fringe and the same Unit must be entered on the Detail line item.

10.6-5

Fringe Cutoffs

When you create a fringe percentage the percentage you enter will be
multiplied by the Subtotal for that line item giving you the result for that
fringe.
For example, if you enter 12% for a Fringe Benefit by Percentage and the
Subtotal for that line is 10,000, the fringe result displayed would be:
12% of 10,000 = 1,200 (as shown below):

If you enter a Cutoff amount for the fringe, then the calculation would override
as follows:

12% of 3,000 = 360 (as shown below):
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10.6-6

Saving and Importing Fringe Groups

You can save and import fringe groups (groups of fringes) and import them into
other Gorilla budgets, saving you the time of recreating them again.
To save a Fringe Group, select Fringe Management from the Setup menu.

Select the Save button for the Fringe Group you want to save.
If the “Automatically save to My Fringes folder” is checkmarked, the saved
fringe file will save in the My Fringes folder in your Saved Budgets folder.
If you delete this fringe group, you can later import it by selecting Import
Group and finding the saved fringe file.
Fringe Group files are saved with a .fri extension.
To import a Fringe Group file, select the Import Group button.
Locate the Fringe Group saved file. By default all Fringe Group saved files are
saved in the My Fringes folder in your Saved Budgets folder.
The Fringe Group file will import into the current budget.

10.7

Units

A unit is a measurement label used for a detail line item.
To create, modify, or delete a Unit, select Units… from the Setup menu:
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Or select Units from the Globals, Fringes, etc. Toolbar:

You will be taken to the Setup Units screen, as shown below:

All Units, unless flagged as “No”, are values measured in hours.
Here you can create a unit for Day and assign it a value of 8.0 (for an 8-hour
day) or 12.0 (for a 12-hour day).
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The Key field is a shortcut that you can use to enter into the Unit field on the
detail line to enter that Unit.

To permanently delete a Unit select the red delete button for the unit in Setup
Units:

10.8

Locations

You can enter a location for each detail line item.
To set-up locations, select Locations from the Setup menu:

Or select the Locations button on the Toolbar:
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This will take you to the Locations screen:

To add a new location, select the green add button.
Enter a short name for the location and a description.
By default the checkbox for Include in Budget is selected, which indicates that
any detail line item that is flagged with the location will be included in the
budget for reports.
The Total for Budget allows you to quickly see how much is will cost for all
detail line items flagged for that location.
To attach a location to a detail line item, select the Location column for the
detail row:

A list of locations will display in a pop-up window:
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Select a location.

The short name of the location will appear in the Location column.
If you return to the Location screen, by selecting Locations on the Toolbar, you
will see the total for that location.

10.9

Sets

You can enter a set for each detail line item.
To set-up locations, select Sets from the Setup menu:
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Or select the Set button on the Toolbar:

This will take you to the Sets screen:

To add a new set, select the green add button.
Enter a name for the set and a description, if desired.
Only the first 3 letters of the set name will appear on the detail level for
reference.
By default the checkbox for Include in Budget is selected, which indicates that
any detail line item that is flagged with the set will be included in the budget
for reports.
The Total for Budget allows you to quickly see how much is will cost for all
detail line items flagged for that set.
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To attach a set to a detail line item, select the Set column for the detail row:

A list of sets will display in a pop-up window:

Select a set.
The abbreviated name of the set will appear in the Set column.
If you return to the Sets screen, by selecting Set on the Toolbar, you will see
the total for that set.

10.10

Currency

The currency feature allows you to add different currencies to the budget. This
is useful if you are doing a multi-national production where monies are being
funded from different countries.
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To access the Currency feature, select Currency from the Setup menu:

Or select Currency from the Toolbar:

When you create currencies for your budget, only 1 currency can be the base
currency.
In the example below, the US$ is the only currency shown and is the base
currency.
Notice the rate in the Rate field is: 1.000000.
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To create a new currency, first see if the currency you desire is in the Quick
Pick pull-down menu:

If it is, select it.
A new currency will be created.
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Notice that the Base value is set to: Conv, which stands for Converted.
The Rate field is empty.
Using your Macintosh or your Windows computer, use the built-in conversion
calculator to determine the conversion rate from the base currency to the
converted currency:
Macintosh Conversion (using Calculator):

Windows Conversion (using Gadgets)

In the examples above, the current conversion rate from the US dollar to the
EURO is: .736.
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Enter this rate into the Rate field:

To attach a specific currency for a detail line item, go to the detail row and
select the Currency button:

From the list of currencies, select the currency.
Two things will occur. The short name of the currency will appear in the
Currency column. Also the subtotal value will change based on the conversion
rate of that currency:

In the example above the third line of the budget is flagged with a EU currency
symbol. The subtotal should be:
3 (Amount) x 1,000 (Rate) = 3,000 for the base currency.
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However, because is flagged with the Euro currency which is converted to .736,
the final result is:
3,000 x .736 = 2,208.

10.11

Groups

Groups allow you to create a group and attach detail line items to that group.
You can then run a budget report including or excluding detail line items that
are attached to a certain group.
To setup the Groups feature, select Groups from the Setup menu:

Or select Groups from the Toolbar:

Upon first entry to the Create Groups screen, an empty group will be created.
Rename the group and select a color for that group.

To attach a group to a detail line item, select the detail row:
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Then from the Tools menu, select View/Apply Groups:

On the View/Apply Groups screen, select the group you want to attach to the
detail line item:

Once selected, the detail row will be attached to the group. The text color of
that line will also change to reflect the color of the group.
You can attach more than one group to a detail line item.
To attach a second group, return to the View/Apply Groups screen, and select
a new group to attach to the selected detail line item by selecting the green
add button:

Once again, enter a name and select a color for the group.
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Then return to the detail level of the budget, select the detail row, and select
View/Apply Groups from the Tools menu:

Select the group you want to attach.
The color will always reflect the last group attached, even though the detail
line is attached to both groups.

10.12

4th Level

The budget levels are divided as follows:
Topsheet (Category Level)

1st Level

Account Level

2nd Level

Detail Level

3rd Level

You have the option of creating a 4th level for any detail line item (3rd level).
This is not required.
Reason to create a 4th Level: One reason to create a 4th level is to import items
from an Excel spreadsheet to that level. This is useful if you have, for example,
a Makeup Artist or a Prop Master who created a list of everything they need
with prices in an Excel spreadsheet. The Makeup Artist or Prop Master can then
send you the file and you can simply attach it to a detail line item called:
Makeup Purchases in the proper account in your budget.
To access the 4th level, select the down blue arrow on a detail row:
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Select the Import button on the 4th level screen:

The Excel spreadsheet can be a .csv or a .xls file.
It should be formatted as follows:

Column A

Item Description

Column B

Amount (Number)

Column C

Quantity (Number)

Column D

Rate (Number)

Select the Excel file when prompted, and you will see the following import
matching screen:
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If all the columns are not correctly filled, then mark a column as empty.
Then select the Import button.

The subtotal will reflect the total amount entered in Column D of the Excel
spreadsheet.
To add, modify, or delete a line item, select either the add row or delete row
button, or simply change the name, amount, X, or rate fields for any entry.
When finished, select the Close button on the bottom of the screen.
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When you return to the detail level, a paperclip next to the detail name
indicates that this row has a 4th level.
The subtotal for the row will be summed in the 4th level and will override any
entry on the detail level.
To remove the 4th level, go back to the 4th level screen and select the red
delete button on the top of the screen:

10.13

Import from Scheduling

Gorilla’s Budgeting module can import selected items from Gorilla’s Scheduling
module.
Before you access this feature, you must make sure that your budget is linked
to an existing schedule.

10.13-1

Linking a Schedule to a Budget

To link a schedule to a budget, select the Select Budget button on the Budget
Toolbar to return to the Budget Manager.

From the Budget Manager, select the Link button for the budget you want to
link a schedule to:
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You will be prompted to select an existing schedule. Only schedules are
attached to the Project will be displayed:
Select a schedule from this list.
When you return to the Budget Manager, the Linked to Schedule field will
display the schedule selected.

10.13-2

Import Crew from a Linked Schedule

To import items from a linked schedule, you must be in the detail level of the
budget.
From the detail level of the proper account you want to import scheduling
items to, select Import Scheduling from the Edit menu, then select one of
the options displayed:
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So for example, if you want to import crew from a linked schedule, first select
the account in your budget where you want to attach crew to. Every budget is
different and has different account numbers. In the example below, we are
selecting the account: 6400-00 DIRECTOR OF PHOTOGRAPHY to import a crew
member from the crew module in our linked schedule.

Once in the proper detail screen, selecting Import Crew will result in the
following screen:
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Again, only crew created in the linked schedule will appear.
You can select a single crew member, or select the Select All button to import
all crew members from this list.
In the example below, we selected just the Director of Photography.

If shoot days are attached the crew member and a rate, these items will also
import into the detail line for this crew member.

10.13-3

Import Actors from a Linked Schedule

To import an actor or a group of actors from a linked schedule, go to the
account where you want to import the actor or list of actors on the budget and
enter the detail level.
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Select Import Scheduling from the Edit menu on the detail level, and then
select the sub-menu, Import Actors.

Only actors that are entered for the schedule will appear on this screen. They
do not have to be cast to a character. Notice in the example above, only three
of the five actors have been cast to a Character.
Select a single actor, or select the Select All button to import all actors to the
detail level of the budget. If a rate is entered for the actor in the Contacts
module, then the appropriate rate will import into the detail level.

10.13-4

Import Element from a Linked Schedule

To import an element or a group of elements from a linked schedule, go to the
account where you want to import the element or list of elements on the
budget and enter the detail level.
Select Import Scheduling from the Edit menu on the detail level, and then
select the sub-menu, Import Elements.
In the example below, we selected the account: 6800-03 PROPS.
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From the Import Elements into Budget screen, select the appropriate category
your want to import an element or a group of elements from:

Select the element you want to import, or select the Select All button to
import all the elements for the selected category.

10.13-5

Captions

When you print a budget report, you can specify caption names to display on
the top of the reports. To access this feature, select the Caption button on the
Budget Manager screen:
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You can enter names to appear on the left side or the right side of the report.

Select a title from the Title pull-down menu.
From the Name field, select a name from the Contacts module to correspond
with the title.

You can also manually type in a title or a name if it is not in the list.
When you print a budget report, the titles and names entered will appear on
the left and/or the right side of the report:
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10.14

Printing Budgets

To print a budget, select Print from the File menu.

The Budget reports screen will appear:
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Select a section from the Select a Section window, then select a Report from
the right window.
If you select Sample, a sample of the report will display with sample data.
If you select Preview, your data will be gathered for the selected report and a
preview window will appear. You can choose to print from the preview
window, if desired.

10.15

Converting a Gorilla 4.8 or 4.9 Budget

You can convert a Gorilla 4.8 or 4.9 budget into Gorilla 5.
To prepare your Gorilla 4.8 or 4.9 budget file, launch Gorilla 4.8/4.9 and save
the budget to a .grb file. Place the file on your desktop or hard drive
somewhere.
Then launch Gorilla 5, and select Convert Gorilla 4.8/4.9 Budget from
the File menu.

Select the Import .grb button, and locate the saved Gorilla 4.8/4.9 budget file.
Follow the steps indicated on the screen:
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Step 1
Select the Step 1 button. Locate the Gorilla 4.8/4.9 budget file and select
Open (as shown below):

The next screen will prompt you to rename the old Gorilla file.
You do not need to do this, but renaming it with Old at the end of the name
will let you know that it is an old Gorilla budget file.
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The next window prompts you to save the new file. If you save the new budget
file in the same location as the Old file, then you do need to rename the old
budget file. Otherwise, save the new converted budget file somewhere else on
your hard drive.
After the file is converted, it will open as a FileMaker 11 data file. You will see
the following dialog box:

When you see this message, select OK, and then select Hide Window from the
Window menu:
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Step 2:
Select the Step 2 button. Locate the converted budget file saved in Step 1:

Locate the file and select Open.
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The next dialog box will appear:

Select OK.
Step 3:
Select the Step 3 button.
The budget will be loaded into Gorilla 5, automatically creating 4 default
percentages. When finished, the budget will appear in the Loaded Budgets tab.

10.16

Load Excel Budget

To import a budget created in Excel into Gorilla, select Load Excel Budget
from the File menu.
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A budget created or exported into Microsoft Excel must be formatted properly
in order to be imported into Gorilla 5.
See accompanying file: Gorilla Excel Import.xls for a sample file.

Above is a sample screenshot from this file.
Column A

Production Total Name

Column B

Account Number (or Category Number
on Topsheet of Budget)

Column C

Account Name

Column D

Sub-Account Name. These are subaccounts related to the primary
account.
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Column E

Sub Account Name

Column F

Detail Name

Column G

Amount (number)

Column H

Units (Text)

Column I

X (number)

Column J

Rate (number)

Some additional rules:
Percentages must be entered in decimal format.
Example:

62% should be entered as .62
6.2% should be entered as .062

The Total for a line is calculated as such:
Column G x Column I x Column J = Total
Therefore:
If the Column G field is NULL, Gorilla will enter the value “1” in this field.
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If the Column I field is NULL, Gorilla will enter the value “1” in this field.
If a value is entered in Column J (the Rate field) and the value in Column F is
NULL (see below), the value in Column E will be copied to Column F so that this
detail line item has a name.

Using the same example above, the rows with Column F that are valid will,
naturally, use that field in Column F for the Detail Name field.
Production Total breaks will be determined by the position of a value in
Column A. In the example below, after the Account 1600, there will be a
TOTAL for all the accounts above and including 1600. The next section break
will occur with the Account 2000, PRODUCTION and end when there is a value
in Column A, for example: POST PRODUCTION on line 200.
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11. Expenses
The Expenses Module allows you to set up money accounts and track expenses
against the budget. Use it much like a check register, entering all payments to
cast, crew, and vendors.
Gorilla can then compare expenses to the budget to see if the budget is on
track.

11.1

Creating an account

To create an account, do the following:
From the Gorilla Toolbar, select the Expenses button and then the Register
button:

Create a new account:
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Enter a name for the account and link it to an existing budget.
Now that an account has been created, you can attach budget account line
items to this account either from the Register screen, or directly from the
budget.

11.2

Accounting Mode

You can turn on accounting mode for a budget in the Budget Manager.

Select the accounting button to turn on or off accounting mode.
If Accounting Mode is turned on, you will be able to attach an account to a
money account.
Turn accounting mode on, and go to the Account Level (2nd level) of the
budget.
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Notice that the accounting button is displayed on every account level line item.

11.3

Attaching an Account to a Money Account

To track an expense against an account, select the accounting button for the
account you want to add a transaction for to go to the Transaction Register
screen:

By selecting the green add button, you can enter a transaction for this account:

Clicking on the Detail button allows you to specify which money account to use
for this transaction:
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In order to track the expense against a specific account, select an account
from the Amount Drawn from Account field.
In this way you can apply payments against this account. To enter a second
payment, select the green add button again on the Transaction Register
screen.

Enter a new transaction, and click Detail to enter a money account for this
transaction.
When you return to the Account level of the budget, you will see the Amount
Paid for the account.
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To hide this column, turn off Accounting Mode in the Budget Manager for this
budget.

11.4

Adding Transactions from the Money Account

To add a transaction from the Accounting Module, select the Accounting button
on the Toolbar:

You will see the Manage Money Accounts screen:

To select an Account to view or add transactions for, select the account from
the pull-down menu:
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To add a transaction to a money account, select the green add button or select
New Transaction from the File menu. Enter the Pay To and the Amount
field.
It is also required to enter the Account to track this expenses against in the
budget.
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12. Contact Info
Website: www.junglesoftware.com
For tech support, please email us:
support@junglesoftware.com
For marketing opportunities, or to become a reseller of Gorilla, e-mail Aaton
Cohen-Sitt:
aaton@junglesoftware.com
For custom database solution, please contact Debbie Cohen-Sitt of our parent
company, The Database Factory:
debbie@thedatabasefactory.com
We welcome all suggestions to improve Gorilla.
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